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4   Introduction

Google 
Workspace

G
oogle Workspace, formerly known as GSuite, is an important 

tool used in the day-to-day functioning of several organizations. 

Docs, Slides, Sheets, or any other service like Forms offered by 

Google, have become a mainstay in the modern online work-

flows, and there are high chances that you would have recently used one of 

the many services available. There are a lot of customisation options avail-

able in Google Workspace too. Right from the pricing of the plans that one 

can choose when getting started to setting up the apps differently according 

to their needs, making using the apps available a much more intuitive and 

collaborative experience.

In the world that we live in, online collaboration has taken precedence 

over the traditional forms of communication and working. Highlighting 

this, Google wrote in a blog post, “Google Workspace is at the nexus of 

Google’s own transformation. After all, Google Workspace was built in 

the cloud to power flexible, real-time, anywhere creation and equitable 

collaboration. Whether it’s with our Google Meet Series One hardware 

kits that enable safe, touch-free meetings and use Google AI to create 

immersive and inclusive experiences for all. Or the ways we help people 

The older folks around know me 
as GSuite.
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focus their time and attention with intelligent, proactive suggestions that 

thoughtfully connect distributed content, people, and conversations. Or the 

features that promote inclusion, like live captions in multiple languages, 

so that everyone can participate effectively in video meetings. It’s all part 

of Google Workspace’s mission to enable a hybrid work experience that 

enhances collaboration, strengthens the human connection, and increases 

wellbeing for people—wherever they are and however they work.”

Given our familiarity with other tools working online and offline, 

most of us have a decent understanding of what the services that come 

under Google Workspace have to offer. The consumer versions of these 

apps make it easy enough for teams to communicate and collaborate, and 

they’re free. So, you should consider upgrading your business to Google 

Workspace, previously known as G Suite for Business. However, many 

of us often tend to miss out on the small hacks, tips and tricks that would 

help us step-up our utilisation of these services. In this book, we attempt to 

cover these tips and tricks and step-by-step guides to help the uninitiated 

get started using Google Workspace tools if they want to. 
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Introduction 
To Google 
Workspace

T
here are high chances that you and your team use Google to optimise 

your productivity. Whether it is Gmail, Google Drive to share docu-

ments, folders and presentations with your colleagues or Google Duo 

to stay connected with friends and family, the truth is everything you 

need to get anything done is now in one place!

Google Workspace includes all of the productivity apps that you have most 

probably used before in one way or other— Calendar, Gmail, Docs, Slides, Drive, 

Sheets, Meet, etc. With Google Workspace, you can create, communicate, and 

Know what it costs and does
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collaborate regardless of where you are, whether you’re at the office, at home, 

or on the front lines with your mobile device.

To keep it brief, Google Workspace is created with the aim to provide organi-

zations more productivity and management tools. Hence, you can collaborate 

more effectively, and boost overall productivity.

Getting started with Workspace
In addition to popular services like Gmail and Google Drive, Google Workspace 

also includes a range of other useful productivity tools. 

GETTING STARTED
1. Adding a Domain to Google Workspace

Google Workspace’s domain service is the first thing you need to add before you 

start. You can do this by following the instructions below.

•	 Scroll down to your Google Workspace service and click the Get Started 

button from the Overview screen in your Account Center.

•	 After this, you will be taken to the Google Workspace setup screen. Select 

either ‘Yes’ if the associated domain is the one you wish to use or ‘No’ if you 

wish to use a distinct domain.

•	 If you select No, you will be asked to enter the domain you would like to 

use before moving on. If you already have an active domain in your Media 

Temple account, you can input it or select it.

•	 You will be prompted to create a Google Workspace account once you’ve 

chosen which domain you want to use with Google Workspace. You will 

use this set of credentials to access the Google Workspace Admin Panel, so 

don’t forget them!

•	 Click on the Complete Setup button to continue.

Your Google Workspace Super Admin user has now been created!

 

2. Log in to the Google Workspace Admin Panel

The Google Workspace Admin Panel allows you to manage your Google Work-

space settings with this user. 

You can access it by following these steps:

•	 From your Account Center, go to the Google Workspace page and click the 

Google Workspace Admin button.

•	 The Google Workspace login page will appear. To continue, enter your Google 

Workspace Super Admin credentials. 
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3. Verify Your Domain

You will need to verify ownership of your domain with Google after setting up 

your admin panel. Adding a TXT record or CNAME to your DNS zone file is 

the recommended method for verifying your domain.

4. Add an Email User

The Google Workspace Admin panel or Account Center can be used to add new 

email users to your Google Workspace account.

Setting up an account 
Google Workspace comes with different options. You can select the option as 

per your requirement. Listed below are the different available options:

1.	 Individual edition: If you do not own any domain and have a personal 

Gmail address, you can sign up to Google workspace using your existing 

account. This category helps small business owners to be more productive 

and professional in doing business. It is designed for one-person businesses 

that use personal account domains like gmail.com.

2.	 Business and Enterprise editions: If you have multiple users and own your 

own domain, you can sign up for the Business or Enterprise edition. Under 

this option, there are different categories, and you can choose one based on 

business size.
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Category 1 - Business Starter edition
•	 It is good for businesses with up to 300 members, and you get a custom 

email address for your business.

•	 Business editions of Gmail, Drive storage, Online documents, Calendar, Meet 

video conferencing, and other office apps are included here.

•	 You can set up a business meeting and invite up to 100 people.

•	 Administrative controls over user access, service policies, and mobile devices 

is also an important feature provided here.

Category 2: Business Standard edition
•	 It works best for businesses with up to 300 users but needs more storage 

space. It offers 2TB cloud storage added for each user.

•	 You can set up a business meeting and invite up to 150 people.

•	 You can record meetings and save them in your Drive, you also get 

shared team drives.

•	 Option to chat outside your organization.

•	 Company search across Google Workspace services.

Category 3: Business Plus edition
•	 It is good for businesses with up to 300 users but needs more storage space, 

with 5TB of cloud storage added for each user.

•	 You can set up a business meeting and invite up to 250 people.

•	 Premium analytics, email encryption, and security controls.
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•	 Data retention and eDiscovery with Google Vault.

•	 Automated mobile-device controls and tracking.

Once you have signed up for Google Workspace, you can get started 

depending on your business size.

Schools and Nonprofits
Google Workspace is also available for schools and nonprofits. Schools can 

set up Google Workspace for Education Fundamentals — communication 

and collaboration tools to empower learning and teaching. You also have an 

option to upgrade for additional capabilities with Google Workspace for Edu-

cation Standard, the Teaching and Learning Upgrade, or Google Workspace 

for Education Plus.

For non-profits, the first thing to do is check if you’re eligible for a Nonprofits 

edition through the Google for Nonprofits program. Once you activate your Non-

profits edition (free of charge), you will get the option to upgrade to the Business 

for Nonprofits or Enterprise for Nonprofits, at prices discounted for nonprofits.

Google Workspace: Pricing
The pricing plans vary for different options that we discussed earlier. Here’s a 

look at how they are structured:

Business Starter: The plan is available at a discounted price of  ̀ 125 per user 

per month at present from the usual price of  `210 per user per month. Under 

this plan you get:

•	 Custom and secure business email.

•	 100 participant that can join video meetings and 30 GB of cloud storage 

per user.

•	 Security and management controls and standard support.

Business Standard: The plan is available at a discounted price of  `672 per 

user per month at present from the usual price of  `840 per user per month. 

Under this plan, other than the above features, you get 150-participant video 

meetings and 2TB of cloud storage per user.

Business Plus: The plan is available for `1260 per user per month. Under 

this plan, you get:

•	 Custom and secure business email + eDiscovery, retention.
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•	 500 participant video meetings + recording, attendance tracking, and 5 TB 

cloud storage per user.

•	 Enhanced security and management controls that includes advanced end-

point management and Vault.

Enterprise: You can contact Google’s sales team to get a price quotation for this 

plan. You get:

•	 Custom and secure business email + eDiscovery, retention, S/

MIME encryption.

•	 500 participant video meetings + recording, attendance tracking, noise 

cancellation, in-domain live streaming.

•	 Storage space is unlimited - as much as you need.

•	 Advanced security, management, and compliance controls, including Vault, 

DLP, data regions, and enterprise endpoint management.

•	 Enhanced support compared to other plans.

Know what it costs
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What changes does WorkSpace have? Let us understand G Suite vs 
Workspace
In October 2020, Google officially announced that it has rebranded GSuite as 

Google Workspace. The original set of tools that were included in G Suite were 

Google Talk, Gmail, Google Calendar, and Google Page Creator. Gradually, it 

expanded and also included Google Sheets, Docs, Google Drive, Slides, Forms, 

Google Chat, and Google Meet. As part of the evolution of G Suite, Google 

Workspace was introduced. This isn’t even the first time the name has changed.

Simply said, Google Workspace is basically the same service as GSuite at 

its core. In 2020, Google made several changes that culminated in this change. 

There is a deeper integration between the different tools. Rather than having the 

users jump between Docs, Drive, Gmail, Meet, etc., everything can be accessed 

in one central spot.

What’s new?

Workspace is not just rebranding from Google. They have introduced some 

brand new features for the platform. Through Workspace, Google targets to 

integrate multiple communication services into a single centralised interface. 

It is estimated that this concept will gradually be expanded in the future.

Google Workspace particularly works very well for those users who 

constantly have to toggle between instant messaging, email, voice calls, and 

video calls.

Here is what has changed in WorkSpace:
•	 	New logos and new branding: Changing the name of Google Workspace 

signals to users and customers that the apps are more integrated and con-

nected. Therefore, the Workspace application logos are now changed and 

they follow the current Google logo color scheme.

•	 Integrated user experience: Since with Google WorkSpace, one app 

combines all features, users will enjoy a new integrated user experience. 

•	 Suitable for different users: Time and again, Google brings to the users 

new ways to get started with solutions that are customised to the individual  

needs of thier broad array of consumers. Google Workspace is now also 

available to educational institutes and non-profit customers. There has 

also been an adjustment to the licenses. The new Business Plus subscrip-

tion gives business customers 3TB more storage per user and allows 100 

additional meeting participants than the previously existing Business 

Standard subscription.
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Google Workspace vs G Suite pricing

With regards to pricing, Google Workspace offers a similar model to G Suite, 

compteing with other remote working solutions, such as Microsoft 365. However, 

Google Workspace does bring to the users a new payment tier. The Workspace 

Business Plus plan costs $18 per user per month. This Business Plus Plan 

comprises of number of upgrades over the Standard plan, which also includes 

more storage, enhanced security, and also a significant increase in the maximum 

number of participants per meeting.

Again, this can be compared to few other well-accepted remote working 

solutions. For instance, Microsoft has a Business Premium tier that costs $20 

per user per month. 
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Google 
Calendar

T
ime-management and scheduling calendar services by Google are 

available through Google Calendar. Its beta release was on 13th April, 

2006, while it was released to the masses in July 2009. Google Cal-

endar is available on both web and as a mobile app for the Android 

and iOS platforms.

Users can edit and create events in Google Calendar. You can set up reminders 

for events and choose the type and time of reminders. Additionally, users can 

add locations and invite others to events. Users can toggle the visibility of 

unique calendars, such as Birthdays, which retrieves dates of birthdays from 

Google contacts and displays birthday cards yearly, and Holidays, which dis-

Save the date
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plays country-specific dates associated with holidays and special occasions.  

Over time, Google has added practical functionalities which make use of machine 

learning. These include:

•	 Events from Gmail: Herein, information about the event is taken from user’s 

Gmail are automatically linked to Google Calendar;

•	 Reminders: Herein users add their personal to-do activities. They can also 

automatically update it with new information;

•	 Smart Suggestions: Here, the app recommends related titles, relevant con-

tacts, and ideal locations when users create events;

•	 Goals: Here, users are allowed to enter relevant data on a specified personal 

goal. An activity is scheduled automatically at a time when it is most effective.

Features of Google Calendar
•	 Users can add and edit events in Google Calendar. There is an option for an 

“All-day event” that has a set start and end time.

•	 Users can enable a “Recurring” functionality with optional parameters 

for frequency.

•	 Users can add a specific colour to an event for easy recognition or to distin-

guish the event from others.

•	 Events are viewable in different types of setups, such as: day, week, month.

•	 Locations can be added to give better understanding of an event’s place.

•	 There is an option to set notifications, including the type (email, mobile push 

notification) and time of the notification.

•	 Users can invite other people to events; for other Google Calendar users, the 

event becomes visible in their calendar, and for non-Google Calendar users, 

an email will have options for “Yes”, “No”, or “Maybe” to respond to the invite.

•	 An individual or an entire calendar can be made public or private by changing 

the privacy settings. Regardless of the calendar’s default setting, users can 

specify a different time zone for events.

•	 Privacy settings allow the user to define the levels of public visibility of 

the entire calendar or individual events. Although the calendar defaults to 

showing users event times in their local time, users can specify a different 

time zone for an event.

Create, reply to and update events  
To access the desktop version of Google Calendar, visit https://calendar.google.com. 

If you are on a smartphone or a tablet, you will basically need to download the 

app through your app store. 
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Android users would probably have the app already installed on their phones.

Create An Event In Google Calendar
Google Calendar makes it very easy to create an event. To create an event in 

Google Calendar, here’s what you need to do:

•	 Open Google Calendar to the calendar you want to add the event to and click 

the “Create” button.

•	 The configure event window will appear as shown in the screenshot above. 

Type in a title for your event in the text box marked “Add Title”. Next, set a 

date for your task as indicated in the screenshot above. Optionally, you can 

configure: adding guests, adding a Google Meet conference, add location, 

and add description or attachments.

•	 Once you have the event configured the way you want, click the “Save” button 

to save your event to your Google Calendar.

•	 Your event will now appear on your Google Calendar.

Creating and managing calendars
If you wish to organize events or share with specific people, you can create sepa-

rate calendars. There is an option of “Add calendar” on the left sidebar. Clicking 

on it opens a form which must be filled out. Though you can create calendars 

for as many or as few topics as you’d like, consider at least setting up separate 

You should have saved the date



17Google Calendar    Google Calendar

personal and work calendars. With this, you will be able to share your work 

availability with team members and maintain your privacy.

Import existing calendars into Google Calendar
If you’ve been using Microsoft Outlook or a different calendar app to manage 

your daily schedule, switching to Google Calendar is easy. You can connect all 

your information to do Google Calendar by following the below steps to import it:

•	 Export data from your source calendar. The option to “Export” can be found 

in the “File” tab. 

•	 Click “Import and export” on the left sidebar in Google Calendar Settings. 

•	 Import the file you exported from your other calendar.

Send an Invite in Google Calendar
Let us say you have created an event and now 

you want to send invites to different people for 

the same. Google Calendar enables you to do this 

in just a few simple steps, which are:

•	 Open the event you want to share in 

Google Calendar

•	 Click on the “Edit event” button 

•	 Under “Guests”, type in the email address of 

the person(s) you want to invite to your Google 

Calendar event

•	 Next, set the guest permissions in the “Guest 

permissions” section and click the “Save” 

button

•	 Finally, click the “Send” button when asked whether you would like to send 

the invitation email to your Google Calendar event.

You can also make a guest optional by selecting their icon ‘People’. Hover 

over the guest’s name if you don’t see the icon. You can save your event once 

you have finished editing it. Your guests will receive an email invitation when 

you save your event.

Set a Reminder in Google Calendar
Setting reminders in google calendar is easy and straightforward. This can be 

done by following the below mentioned steps:

•	 Under My calendars”, make sure that “Reminders” is checked.

•	 Click the “Create” button.
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•	 Next, click on the “Reminder” tab.

•	 Set the time you want the reminder to trigger and click the “Save” button. 

Create a Recurring Task in Google Calendar
There are times where few events will be recurring like team meetings which 

would probably take place at the same time on each working day. So in those 

cases, Google Calendar provides an option to schedule it as a recurring event. 

Just follow these steps:

•	 Open your event in Google Calendar and click the “Edit event” button.

•	 Click on the “Does not repeat” drop-down button.

•	 A pop-up menu will appear with some preset recurring time options. Choose 

one of those or choose “Custom” if you want to set a customized recurring 

interval for your event.

•	 Click the “Save” button to save your recurring schedule to your event in 

Google Calendar.

•	 Your event will now recur based on the recurring schedule you set.

Tasks and Reminders of Google Calendar
What’s the difference between Tasks and Reminders?

Google Reminders vs. Tasks differs in one of the most important ways. They 

both have the ability to schedule daily tasks. Rather than using sticky notes, 
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which are susceptible to getting lost, these can be used. Though they may seem 

similar in use, their function and interface are still different.

•	 Google Reminders is an app which is integrated with both Google Assistant 

and Google Calendar to set and complete reminders.

•	 Google Tasks is an app that is developed and organized by Google specifically 

for adding tasks with reminders. Users can then mark them once they are 

completed. This allows you to formulate multiple lists in order to organize 

your work more effectively. For example, keep one list for work, and keep 

another for personal work.

Which one is suitable for you?

Whenever you need to schedule an activity requiring details, Google Tasks is 

a useful tool. Google Reminders, on the other hand, is a great option for those 

looking for a simple way to remember a task. In other words, you need to con-

sider what you’ll use both for. Google Reminders is the perfect tool for creating 

occasional reminders.

Get add-ons
While the inbuilt features and capabilities of Google Calendar are exhaustive 

enough, there are quite a lot of extensions that you can add on to it in order 

to enhance its functionality. This will also allow you to customize your daily 

scheduling – whether it is for professional or personal life.

You can save time and effort for your users by extending Google Calendar 

with Google Workspace add-ons. With a Google Workspace add-on, the user can 

And it done… Nope, still have to write 6 chapters
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interact with a third-party system without having to switch to a new browser 

tab. You can accomplish a lot with what Google suite alone provides, but many 

times, you might need a little more than what it gives. 

This is where add-ons come in. Here are some of the best add-ons for Google 

Calendar out there:

1. Zoom for G Suite:

Zoom for G Suite integrates into 

both Google Calendar and your 

Gmail. This will allow you to 

smoothly and quickly schedule 

Zoom meetings with necessary 

details taken from an email.

The native integrations of 

Zoom would enable your users 

to flawlessly schedule, start, 

and join Zoom meetings from 

their G Suite workflows. The in-built integrations can be conveniently accessed 

from both desktops and mobile devices, as well as centrally managed by IT. Zoom 

offers consistent and hassle-free access to G Suite. With integrations supporting 

single sign-on and login with Google, you will get a frictionless login experience.

An extension for Google Calendar called Zoom for Google Calendar enables 

you to do this. A manager scheduling meetings for multiple people with different 

meeting preferences (enabling automatic recording, waiting room, meeting 

password, etc.) would benefit from using this.

Any email you send can instantly be escalated to a Zoom meeting using the 

Zoom for Gmail add-on. Using the add-on, you can automatically send calendar 

and email invitations to everyone on the thread. After the meeting is complete, 

the add-on sends a meeting summary to the participants.

 

2. GoTo for Google Calendar:

GoTo is online collaboration software that makes it uncomplicated to connect 

with your peers and family over the internet and even across the globe. With 

the Google Calendar integration for GoToMeeting, you’ll be able to effortlessly 
schedule, accurately manage and smoothly join upcoming meetings directly 

from your Google calendar. You can manage and edit your schedule just with 

the push of a button and join back-to-back meetings easily without ever having 

to leave the Google environment.
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3. TimeNavi: 

TimeNavi is an useful add-on which enables you to use it as your personal time 

management assistant. This simply means that it will explore your events by 

making use of a wide array of information, and use it to get a clear idea of how 

your time is being utilised. With the TimeNavi’s “Export” button you can see 

your personal calendar in just 2 clicks. It gives you time management tips and 

shows how well you can manage your day in real-time. This makes time manage-

ment efficient and fun! Other features that TimeNavi provides are a dashboard 

of your team’s time spent and prompt income calculations.

4. Shared Contacts for Google Calendar: 

Shared Contacts for Google Calendar enables you to see the contact details of 

those with whom you share your Google Calendar events. It is available as a 

Chrome extension, a web app, or a mobile application. By using Shared Contacts, 

you will never have to copy-paste contact details to wherever you need them 

including the spreadsheets again.

You can share the email signatures, same calendar events, and team files with 

your team without needing to re-share even the smallest of items with every 

new team member. You can share Google Contacts directly from Google Drive, 

Gmail, Google Calendar, or even Google Contacts Manager. In collaboration 

done with Google, you can have access to Shared Contacts which is a different 

and upscaled version of Google Workspace.

5. Appointment Reminder: 

Appointment Reminder is ideal for professionals who use Google Calendar for 

booking clients into appointments. This is a useful Google Calendar add-on that 

helps you stay on top of your schedule and hence making sure that you never 

miss your appointments. Using the Appointment Reminder add-on for Google 

Calendar, you can send automatic SMS reminders to your clients to reduce no-

shows and improve communication.

With your own personalised booking page, you can also give your clients 

appointment reminders and allow them to book online, showing only the times 

you are available. You can include the service provider, appointment date, time, 

location, or any other kind of information. Their system pulls data from your 

Google Calendar, and the inbuilt templates are completely customizable! 
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Docs, Slides 
and Sheets

In Google Drive, you can create and access Google Docs and other prod-

ucts from Google. You can use these products to collaborate with others. 

Below are the three different products you can use:

•	 Google Documents (known as Docs): It is an online word processor to 

create and format text documents.

•	 Google Spreadsheets (known as Sheets): It is an online spreadsheet 

application to create and format spreadsheets and charts.

•	 Google Presentations (known as Slides): It is an online presentation 

editor to create visual presentations and shows.

In this chapter we dive into each of these three products.  

Write, calculate, and present
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Google Sheets

Features
Below are some features of Google Sheets you must know. These can make 

your life an easier:

Switching from Excel

For many years, Microsoft Excel has been the leading tool that has been 

widely used by many for creating spreadsheets. Meanwhile, Google Sheets, 

its free Excel alternative, is becoming more and more prevalent. The most 

well-known spreadsheet applications today are Microsoft Excel and Google 

Sheets. In terms of formulas and calculations they are pretty much identical. 

This implies that many of their features are mostly the same.

As we already discussed, Google Sheet is a spreadsheet program offered 

by Google. Google Sheets can be used in the form of desktop applications, 

web applications, or mobile applications. Excel and Google Sheets are both 

good tools. They both have some unique features. Google Sheets is best for 

working with data collaboratively. Excel is best for offline calculations and 

analysis. If your team uses Microsoft Excel and Sheets, here are some best 

practices for when to use each product.

Convert existing Excel spreadsheets to Sheets if:

•	 You need to simultaneously edit or collaborate over data with your team.
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•	 Your dataset requirement is 5 million cells or fewer.

Continue working in your existing Excel spreadsheets if:

•	 Your dataset requirement is more than 5 million cells.

•	 If you make use of rare chart types, such as 3D pyramid charts or pie-

of-pie charts.

You can even import data easily from an Excel file to a new or any existing 

Sheets file. Your Excel file would not have any changes, even if you make 

changes in the Sheets file.

•	 In Sheets, create a new or open an existing spreadsheet.

•	 Click File and then click on Import.

•	 Choose the Excel file and then click Select.

•	 Choose an import option: Create new spreadsheet, Insert new sheet(s), 

Replace spreadsheet

•	 Click Import data.

•	 If prompted, click on Open now.
Instead of importing data, you can choose to convert an Excel file to 

Sheets. After this, you can keep working on it in Sheets. Your Excel file 

won’t be changed.

•	 Open Drive and double-click an Excel file.

•	 A preview of your file opens.

•	 At the top, click Open with Google Sheets.

•	 Click File and then Save as Google Sheets.

If you want to automatically convert all the future uploads of Office files 

to Google Sheets:

•	 In Drive, at the top, click Settings.

•	 Next to Convert uploads, turn on Convert uploaded files to Google Docs 

editor format.

You should note here that previously uploaded files will not be converted.

You can work on a spreadsheet in Sheets and then send a copy by email 

as an Excel file (or a PDF).

In Sheets, open the file.

•	 Click File and then Email as attachment.

•	 Under Attach as, choose Microsoft Excel.

•	 Enter the email address, subject, and message.

•	 (Optional) Check the Send a copy to myself box.

•	 Click Send.
Additionally you can also download a copy of the Sheets file in PDF, 

ODS, Excel, CSV, or other formats.
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•	 In Sheets, click File and then choose Download as.

•	 Select the file format you want to download.

Import Data Sets & Spreadsheets

You may have data in a text format or in some other file. One way is to copy 

the data manually into the Spreadsheet. No one would like to do it. Hence, 

Google Spreadsheet has a feature where you can import data sets or a new 

spreadsheet in your existing spreadsheets. Below are steps to follow:

•	 In your existing spreadsheet, select File > Import.

•	 Locate the file you want to import. It can be .xls, .xlsx, .xlsm, .xlt, 

.xltx, .xltm, .ods, .csv, .txt, .tsv, and .tab. 

•	 Select an Import Location. 

The import options will depend on the file type. Below are some options 

you will see:

•	 Create a new spreadsheet: You can create a spreadsheet from the imported 

data in a new browser tab.

•	 Insert new sheets: Add new sheets with the imported data to your 

existing spreadsheet.

•	 Replace the current sheet: You can replace the current sheet’s contents 

with the imported data.

•	 Replace spreadsheet: You can replace the open spreadsheet with the 

data in your imported file.

•	 Append rows to the current sheet: Adds the imported data to the current 

sheet after the last row with any data.

Trust the numbers, not your luck
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•	 Replace data starting at the selected cell: Replace the data in a range of 

selected cells with the imported data.

If you have selected the text file, you need to select the Separator type. It 

can be a letter or symbol that Google Sheets will use to separate cells. You 

will have the below options:

•	 Detect automatically: This will automatically find ways to split your 

data set.

•	 Comma: This will split your data set based on commas.  

•	 Tab: This will split your data set based on tabs. 

•	 Custom: Choose a custom character to split your data. 

The last step is to decide whether to ‘Convert text to numbers, dates, and 

formulas’. In general, you should select “Yes.” Once done, you can select 

the IMPORT option.

Embed Spreadsheets on Websites

You can embed Excel spreadsheets into web pages. Yes, it is possible, and 

you must know this option to make your website more interactive. 

Your website visitors can sort, filter, and calculate data once the Spread-

sheet stored on your drive is embedded in your website. If you update the 

Spreadsheet in OneDrive, your website visitors will automatically see the 

updates on your website. Follow the below steps to get started with embed-

ding spreadsheets to your website:

•	 Place your spreadsheet in OneDrive.
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•	 In OneDrive, right-click the workbook and then click Embed. You will 

see the option of generating - it will generate an embed link.

•	 Click Generate and then click ‘Customize how this embedded workbook 

will appear to others’.

•	 You will see the ‘What to Show’ box. Click on the box and based on your 

requirement select the required options. It will have options like - Show 

the entire workbook, or show a chart, a named range, PivotTable, or table.

•	 Check the boxes for the options you want in the Appearance section. 

•	 Select how you want to allow people to interact with the workbook in 

the Interaction section. For example, if you select ‘Allow sorting and 

filtering’, your website viewers will be able to sort, filter, and expand or 

collapse the tables or PivotTables in the workbook. If you ‘Allow typing’, 

viewers can make it in the cells on your website but it will not be saved in 

the original workbook. For example, if you embed a compound interest 

calculator, you might want to enable typing so that people can fill out 

the investment amount, tenure, interest rates, and other variables. If 

you want to specify a cell to be selected when the blog page opens, check 

the ‘Always start with this cell selected box’, and then click the cell you 

want in the preview.

•	 The last section is the Dimensions section. Under this section, type 

width and height for the viewer on your website, in pixels. To see how 

the viewer will look at the dimensions you have specified, click View 

actual size, at the top of the preview.

•	 When you are satisfied with the preview, click Copy. Next, on your 

website, where you want the excel to appear, in the HTML editing mode 

paste the embed code and your spreadsheet will go live on your website. 

Use scripts

Google Sheets can do a lot of things, but there are some things you may 

want but it cannot do. However, you can use Google Apps Script and make 

anything happen on your Spreadsheet. You can explore existing scripts by 

going to Tools > Add-ons or writing your own script.

Google App Script is a rapid application development platform that 

makes it fast and easy to create business applications. You can code in 

modern JavaScript and have access to built-in libraries on Spreadsheets.

You can use the Apps script to add custom menus, sidebars, and dialogs 

on Sheets. You can also publish web apps and write custom functions and 

macros for Sheets.
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In Google Spreadsheets, you can add and subtract numbers using the 

existing tool. However, let us say you want to double the value in the output 

column of the value you input. You can script a script for the same. You can 

create a custom function using the below steps:

•	 Create or open your Google Sheet and select the menu items Extensions 

> Apps Script

•	 Write the new function and click on the Save button. Start using the 

newly created function.

You can also get several custom functions as add-ons for Google Sheets. 

Once you have installed a function from the Google Workspace marketplace, 

or you have written a custom function on your own, you can start using it. 

Follow the below steps:
•	 Click on the cell you want to use the function

•	 Type the equals sign (=), write the name of the function and give the 

value, and press enter. 

•	 The cell will take a split second and display the result. For example, you 

created a function DOUBLE that multiples any value by 2 and returns 

the result. You can give =DOUBLE(10) and it will populate 20 in the cell 

where you typed the function.

Here are a few things to know while using your own function:
•	 The function name you create should be distinct and not the same as 

any other existing function.

This was made in a second
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•	 Underscore (_) denotes a private function in Apps Script and hence the 

name of a custom function cannot end with it.

•	 Capitalization does not matter, although the names of spreadsheet func-

tions are traditionally uppercase.

Alternatives to Google Sheets
One of the most widely used software tools for organizing and sorting 

information is spreadsheets. Whether you want to manage tasks, coordinate 

projects, record lists, or analyze data, spreadsheets contain features that 

would help businesses of all sizes.

Excel’s built-in functions and calculations make it easy to understand 

large data sets. Depending on how you use it, a spreadsheet can be an inte-

gral part of how you run your business, whether you’re an entrepreneur, 

a freelancer, small business, or large corporation.

As a part of WorkSpace, Google Sheets now provides many of the same 

useful spreadsheet functions as Excel and few other popular spreadsheet 

applications. In the industry, Google Sheets is considered one of the best 

tools due to its free access and cloud-based storage.
However, there are many other tools that can be compared to Google 

Sheets on the basis of their functionality. Here are a few of them:

1. Jotform

Jotform is a great alternative to Google Sheets, since it offers fully inte-

grated forms, data analysis tools, and workflow automation. With Jotform 

Tables, workflows are streamlined by combining spreadsheet and data-

base tools. The table is automatically updated with information collected 

through forms.

To create an all-in-one workspace, users can access a wide collection 

of table templates and tools which are very helpful for team collaboration 

and management. The software is not just capable of performing complex 

calculations, but also of analyzing and visualising data in different formats. 

As part of the data collection and analysis process, Jotform also integrates 

with Google Sheets.

2. Microsoft Excel Online

Microsoft Excel Online is a great alternative to Google Sheets. Excel was 

formerly a hardware-based installation that came with the Microsoft 

Office suite.



30   Docs, Slides and Sheets

Excel is now available in a cloud environment using the Office mobile 

app. Using this app, users can easily access Excel from almost any computer 

or mobile device. Microsoft Online’s price is a bit higher than its competi-

tion. This additional expense allows users to benefit from great customer 

support and the inbuilt dynamic features.

3. LibreOffice Calc

LibreOffice is a free and open-source Office program with a large community 

of developers and users. With LibreOffice Calc, you can create spreadsheets 

that are intuitive and simple to use. There are many styling options in  

Calc, such as freely rotating contents, borders, templates, and backgrounds, 

while the solver lets you solve optimization problems with just a single 

click. It is also possible for users to collaborate on spreadsheets and co-

author them.

Calc makes use of the Advanced DataPilot technology. This technology 

enables corporate databases to be accessed and converted into meaningful 

data. Spreadsheets can be converted into PDFs using the tool, which is 

compatible with Microsoft Excel.

4. Zoho Sheets

Zoho sheets’ AI assistant Zia sets it apart from other spreadsheet software. 

Zia acts as your personal data analyst, so you don’t have to hire a data 

analyst to analyze your data.

Online, offline, everywhere!
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You can add pivot tables to your spreadsheet by dragging and drop-

ping using Zia’s recommendations, aggregating them based on your data, 

or recommending charts based on your data. You can even ask questions 

such as “What was the income last month?” and Zia will run the analysis 

in a few seconds to give you answers!

Also, Zoho Sheets offers more than 350 functions for analyzing your 

data, and even allows you to create custom functions based on your business 

needs. It is possible to have high data inconsistencies when working with 

large data sets. In Zoho Sheets, duplicate values are removed and random 

missing values are filled in to eliminate inconsistencies.

Google Docs

Features of Google Docs

Switch between different formats
When you create a document in Google Docs, the settings by default such 

as line spacing, font style, and background color are automatically applied 

to the document.

On a case-by-case basis, you can modify any of these elements for part 

or all of your document. However, by consistently using the same settings 

Does the job!
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across most, or even all, of your Google Docs, you will end up saving yourself 

time and trouble. You can change the default settings in Google Docs for 

the purpose of formatting.

How to change default formatting in Google Docs
All the documents created after you change the defaults, will reflect these 

settings. You will of course be able to change the formatting of any individual 

element within any document of your choice, but the default format will 

give you a consistent starting point.
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To change the default settings for Normal text in Google Docs, follow 

these steps:

•	 Open a document.

•	 Highlight the text you want to change.

•	 In the bar above the text, select the font, font size, paragraph spacing, 

text color, background color, or any other aspect you’d like to change.

•	 Select Format.

•	 Select Paragraph styles.

•	 Click Normal text.

•	 Choose Update “Normal text” to match.

•	 Click Format.

•	 Click Paragraph styles > Options > Save as my default styles.

You also can change the default format settings for other elements such 

as titles, headings, borders, and shading by following the same process.
Instead of choosing Format > Paragraph styles, select the formatting 

option you would like to apply instead of paragraph styles. The style will 

then be applied to all your documents from now on when you update the 

style to match the selected text.

If you’d like to reset to Google Docs’ original styles, select Format > 

Paragraph styles > Options > Reset styles.

2. Watermarks:
There is no admin control required for the text watermarks feature that 

Google Docs provide. By making use of this feature, watermarks such 

as “Draft” or “Embargo” can be added to documents before you export 

them. This process is quite simple and easy and will save time for Google 

Docs users who wish to generate a document online. They can then add 

watermarks using third-party apps. End users can simply head over to the 

document they wish to add a watermark in, go to Insert, tap on Watermark 

and then select text. It is a very simple and easy process.

How to add a Google docs text watermark?
•	 On your computer, open a document in Google Docs.

•	 Go to Insert  Watermark.

•	 In the panel on the right, click Text.

•	 Type the text you want to appear as a watermark.

•	 Optional: In the panel on the right, you can format your watermark.

•	 Click Done.
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How to add a Google docs image watermark?
•	 On your computer, open a document in Google Docs.

•	 Go to Insert  Watermark.

•	 Click Select image.

•	 Select an image from:

•	 Drive

•	 Photos

•	 The web

•	 A URL

•	 Your camera

•	 An upload from your computer

•	 Optional: In the panel on the right, change the format of the watermark.

•	 Click Done.

How to make changes in your watermark?
•	 Right-click the watermark.

•	 Click Select watermark.

•	 Below the watermark, click Edit watermark.

•	 Tip: If you see some gaps appear in your watermark, it may be because 

the text in your document has a background color. You can remove the 

background color of your text to see the whole watermark.

 

How to Delete your watermark?
•	 Go to Insert and then Watermark to open a panel on the right.

•	 You can also Right-click the watermark.

•	 Click Select watermark.

•	 Below the watermark, click Edit watermark to open the panel.

•	 At the bottom of the panel, click Remove watermark

 

3. Use add-ons,
Google Docs enables you to make use of a wide range of add-ons to make 

the process of document creation simpler. Few of the helpful selections for 

writers include: ProWritingAid for checking your grammar and spelling, 
Track My Words for tracking how many words you write each day and 

your WPM rate & EasyBib for easy and automatic citation.

To find and download add-ons for Google Docs:

•	 Select the Add-Ons option in the toolbar, then Get Add-Ons.

•	 Search for the add-on you wish to download and select it.

•	 Select Download and then Continue.
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Once the add-on is installed, you’ll need to close and open Google Docs 

back up. Only post this, you will be able to use your new tool.

4. Voice Typing tool,
Do you have Google Chrome as your default browser? Do you have a working 

microphone either built into your device or connected externally? Then you 

can easily type in any Google Doc by just using your voice.

Voice typing is a helpful accessibility tool that’s available on Google 

Docs and in Google Slides speaker notes. It’s a feature that’s only available 

in Chrome browsers, and some aspects like voice commands for formatting, 

editing, and punctuation are only available in certain languages.

•	 To command addition of a punctuation mark, simply say the name of it 

out loud, like “period,” “comma,” “exclamation point,” or “question mark.”

•	 To start writing a new line or a new paragraph, say “new line” or “new 

paragraph” out loud.

•	 To get to voice typing, open a document and click Tools from the menu 

at the top of the page.

4. How to use voice typing in Google Docs
To use the voice typing feature in Google Docs, follow the steps below:

1. 	 Open a Google Doc in Google Chrome.

2. 	 On the toolbar, click Tools, then Voice typing.

3. 	 When you’re ready to start voice typing, click the microphone icon in 

the left margin.

 

5. Research tool,
Any Google Docs user who needs to do online research is thankful for the 
Research tool. Here is why. Whether you are a student about to submit 

final papers or a parent helping kids with research assignments, Google 

has simplified the process with this new tool that automates the research 

process. Very much like the Researcher tool in Microsoft Word, Google Docs 



36   Docs, Slides and Sheets

brings to you the Explore tool. This tool enables you to quickly search for 

the topics that are closely related to your document without exiting Google 

Docs. Once you have researched, you can add appropriate content or images 

and even add citations for those sources.

This basically means that the user doesn’t have to click back and forth 

endlessly between various tabs. You can simply open the Research tool on 

your computer in one of three ways given below:

•	 Open your document and open the Tools menu at the top of your screen, 

then click Research from the dropdown menu.

•	 Right-click on a specific word and select Research.

•	 Use the keyboard shortcut Ctrl + Cmd + Shift + I (Mac) or Ctrl + Alt + 

Shift + I (PC).

You’ll probably see related topics when you open the Research tool based 

on what you’ve written already. You can either click on those suggested 

topics or search for your own terms by typing them into the search bar.

You can also choose what type of content you want the tool to come back to 

you whenever you put in a search. You can use the dropdown menu located 

next to the search bar in order to see various types of data for that topic.

6. Include Web Content
Click “Web,” and you will find web results for the subject listed like you 

would when using Google to search. You can click one to go directly to 

that source in a new tab if you want to read more. You can also scroll to the 



37Docs, Slides and Sheets    Docs, Slides and Sheets

bottom of the results and click “See All Results on Google” for a full list. 

This is a convenient way to read up on your topic.

7. Full screen = No distraction
An app’s ever-present toolbars and menus can distract you from writing 

due to their constant presence. For bringing to you the experience which is 

close enough to traditional paper, you can try Full Screen View.

Alternatives to Google Docs 

1. OneDrive for Business
OneDrive is a cloud data storage and file sharing tool brought to you by 

Microsoft. This would be a great tool for your business and organization. 

You can easily store all your information in this cloud drive and can access 

it individually or on a shared basis with your team members. You can also 

work in this drive in offline mode and all your edits will be easily synced 

once you are online again. It works simply, easily and at a great speed both 

inside and outside the organization.

2. Nuclino
Nuclino is a lightweight and fast alternative to Google Docs. It brings to the 

users almost all the features that are popular about Google Docs – version 

history, auto-save of changes, real-time collaborative editing, comments,

and more. When it comes to formatting, options are pretty less extensive. 

However, this is mainly because Nuclino prioritizes the simplicity and speed 
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of the entire editing experience. This enables you to keep your documen-

tation exhaustive and consistent. Nuclino also stands apart among other 

Google Docs alternatives because of its different and attractive approach 

to organizing content. Nuclino is a lot more than just a simple document 

collaboration tool. The list, board, and graph view enables you to organize 

your content visually, hence adapting the tool to your workflow. Apart from 

this, Nuclino is also tightly integrated with Google Drive. This makes it a 

great and feasible Google Docs replacement for those organizations who 

use Google Sheets, Slides, and Drawings.

 

3. Quip
Quip is an exhaustive team collaboration tool which brings together spread-

sheets, checklists, documents, presentation slides, and chat in a single tool. 

Quip can replace not only Google Docs but also Google Drive, Slack, and a 

few other online collaboration tools.

While Quip does not bring to the table the similar advanced formatting 

and customization features that  Google Docs offers, if you are not looking 

to generate documents with advanced layouts, the Quip editor would do the 

job. Also, it makes up for what it lacks in formatting features, by bringing 

extensive collaboration features and rich content embeds.

4. Zoho Docs
Zoho Office Suite comprises Zoho Docs. This tool closely matches the 

functionality of Google Workspace and in some ways is even better than 

exceeds it in many regards.

The editor comprises exceptionally sophisticated formatting options, 

which enables you to create attractive and meaningful documents with 

custom layouts and by also using company branding. Its editor gives a good 

competition to not just Google Docs but also to MS Word.

However, these effective and compelling features come with a bit of a 

learning curve. While the layout is very simple and immaculate, it consists 

of numerous hidden menus and may not seem intuitive to new users.

Google Slides:

Features of Google Slides

Personal Font Library
Using Google Slides is very beneficial and simple. One of the biggest ben-
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efits of this tool is that 

can use the most modern 

fonts which are pro-

vided by Google Fonts. 

For instance: fonts like 

Roboto, Lato, Montserrat, 

and many others can be 

used directly in your 

Google Slides presenta-

tion. You would get access 

to 26 different font options by default with Google Slides. Also, you can add 

more fonts to Google Slides if needed. This is how:

•	 To add fonts to Google Slides, select a text box and click on the “Fonts” 

option in the toolbar. 

•	 Click on “More Fonts” from dropdown. 

•	 Search for the font using the search bar or scroll through the list and 

choose a font. 

•	 Click on it to select it and click on “OK”.

Here is how you can change fonts in Google Slides:

•	 Highlight the text

•	 Select your preferred font

•	 Now all you have to do is click on the new font style and it will be 

automatically saved.

Do note that Fonts visible under the “More Fonts” option are Google 

Fonts. You can also check out Google Fonts for more options and font pair-

ings, and add a specific Google Font using the search function under the 
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“More Fonts” option in Google Slides! You get about 1284 font options in 

Google Fonts currently!

You can also use  “Extensis Fonts” add-on to get “near-unlimited” font 

options in your presentation application. The Extensis Fonts add-on brings 

to you numerous options and font styles that you can choose from! The best 

part is, just like Google Fonts, it is completely editable and free!

Audience Q&A,
You can start a live Q&A session in your Google Slides presentation and pre-

sent questions at any time. Viewers can also ask questions from any device.

Here is how you can start a Q&A session:

•	 Accept audience questions

•	 Open a Google Slides presentation.

•	 At the top, next to Slideshow , click the Down arrow .

•	 Click Presenter View.

•	 In the new window, click Audience tools.

To start a new session, click Start new.
•	 To resume a recent session, click Continue recent.

•	 To end Q&A, click the on/off switch in the Q&A window.
Do note that even if you don’t turn off Q&A, the Q&A view closes shortly 
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after you end your Google Slide presentation. Also, If you use Google 

through your work, school, or other organizations, you can choose who 

can submit questions:

In the “Presenter view” window, click Audience tools and change 

“Accepting questions from…”

How to show questions asked by audience?

Presenters can display questions asked by audience in a presentation:
•	 Under “Audience Tools,” find a question to display.

•	 Click Present.

•	 To change the question, find a different question and click Present.

•	 To hide the question, click Hide.

How to Review recent sessions?

Presenters can see questions from recent Q&A sessions:
•	 Open a Slides presentation.

•	 At top, click Tools and then Q&A history.

•	 Recent sessions appear on the right.

•	 Ask a question

How can audience members can ask questions in a presentation:
•	 Go to the link at the top of the presentation.

•	 Click Ask a question… and type a question.
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•	 Audience members can optionally check the box “Ask anonymously.”

Click Submit.

How can audience members vote on questions?
Audience members can vote on the questions to be answered:

•	 Go to the Q&A link shown on the slide.

•	 Below the question you’d like to vote on, click Up vote Upvote or Down 

vote Downvote.

Publish to web
Webpages are a simple and easy way to share data with large audiences. 

This is because everyone can see them, and you can even have full control 
when updates are released to the public. You can publish a copy of your file 

as a distinct, lightweight web page with Google Slides.

Here is how you can publish a file to we:b

When you publish a file to the web, you create a copy of your file as a 

unique web page with its own URL.

•	 In Google Drive, open your file.

•	 From Docs, Sheets, Slides, select File and then Publish to the web.

•	 For spreadsheets, select the entire spreadsheet or individual sheets.
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•	 For presentations, choose how quickly to advance the slides.

•	 Click Publish.

•	 Copy the link and send it to anyone you’d like to share the file with.

•	 you make to the original file go live when you republish it.

You can choose the presentation size and whether or not you want slides 

to advance automatically. You also need to decide if you want the Presenta-

tion to start automatically and if you want it to loop continuously.

Add and edit GIFs,
There are many different ways through which you can attract your audi-

ence with your presentation. One of them is using visually appealing tools 

so people will be compiled to stay glued to the slides. In fact, a smart use of 

GIFs and other images will help you when explaining complex concepts 

in a cool and modern way. 

Here is how you can add a GIF from your computer:
•	 Open your Google Slides theme.

•	 If you want to insert a GIF or change a default one, you can do so.

•	 Go to the left corner and, in the toolbar, click on Insert, select Image → 

Upload from the computer.

•	 Choose the GIF you’d like to embed and click Open.

•	 Move the image if needed in order to adapt it to the design and layout 

of your slide.

•	 If you want to resize it, click on the GIF image and the outline appears. 

Click on any of the blue squares and drag it while you press Shift. This 

is helpful to keep the image proportioned!

Here is how you can insert a GIF using URLs
Search for the GIF you would like to add.

•	 Click on it → Right click → Copy Image address. 

•	 Open your Google Slides theme.

•	 In Insert, select Image → By URLs.

•	 Paste the link (Ctrl V or Cmd V in Mac).

•	 Move the image if needed.

•	 If you want to resize it, click on the GIF image and the outline appears. 
Click on any of the blue squares and drag it, but don’t forget to keep 

Shift pressed
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Here is how you can edit a GIF in Google Slides:
•	 Click on the image.

•	 Select Format options.

•	 Select Recolor to change the hue of the GIF.

•	 Click on the drop-down menu and choose any of the available options.

•	 Click now on Adjustments. It displays a series of options that you can 

customize, namely three: Transparency, Brightness and Contrast. You 

can adjust them using the sliding bars.

•	 If you are not happy with the results, click on Reset to undo the 

previous changes.

Those are not the only effects that you can apply to GIFs. If it is in tune 

with the design and flow of the template, you can also add a drop shadow 

under it: 

•	 Click on Drop shadow.

•	 Choose a colour.

•	 Change its Transparency, Angle, Distance and Blur radius if needed 

using the three different sliding bars.

To delete the shadow that you have just created, unselect the Drop 

shadow button.

Use Explore
The Google Docs Explore tool enables you to quickly access files in your 

Drive, web search, images, recommendations and much more. The option 
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to Explore is available in Docs, Sheets, and Slides and it uses machine 

learning to try to predict the things you need as you compose and create.

When it comes to Google Slides, you can use the Explore option to add 

suggested content based on what’s in your presentation. You can also search 

your docs and the web from within a presentation.

Here is how you can Use Explore in Google Slides
•	 On your computer, open a presentation in Google Slides.

•	 At the bottom right, click Explore Explore.

•	 In most cases, you’ll see suggestions for layouts to help finish your work. 

Click the one you want.

Here is how you can add images or info from other documents or the web
•	 On your computer, open a presentation in Google Slides.

•	 At the bottom right, click Explore Explore.

•	 At the top, search for a document, presentation, image, chart, or webpage. 

Search results will show in categories:

•	 Web: Info from the web related to your presentation.

•	 Images: Images from the web related to your presentation.

•	 Drive: Documents saved in your Google Drive.

•	 	Add an item: 

•	 Add an image or chart: Click the item you want to add. At the top, 

click Insert.

•	 Add a footnote: Point to your search result. Click Cite as footnote 

Cite as footnote. 

•	 Add a link: Point to your search result. Click Insert Link Insert.

Do note that if you want to see more charts or images from a document, 

click “See more content” under the presentation or document.

Alternatives to Google Slides

As we have discussed, Google Slides has a lot to offer to its users. However, 

there are more options available for similar needs, and some of them have 

additional features you may need for your presentations. Hence, it is crucial 

to check the alternatives to Google Slides. Below are some top alternatives:

Genially  
It can help you create a self-led presentation, and it has some very interac-

tive features. It comes with searchable animated templates for dossiers, 
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reports, social media presentations, and business proposals. It has inter-

active buttons that allow you to show additional content on hover, go to 

external links, and quickly skip to any page. It is a free tool that helps you 

include data visualization, photo galleries, etc. Genially is one of the best 

slideshow-making projects for various niches like business, education, 

design, and institutions.

Powtoon 
If you don’t want to create a boring traditional presentation and want to 

create some super cool animated presentation, you can explore Powtoon. 

It is a free online tool that helps you create dynamic presentations in a few 

minutes. It comes with professional-quality presentation templates that are 

easy to navigate and let you add visual elements to your slides. It has some 

additional features which are rare - choose the video orientation according to 

the target price. Once you are done with your presentation, you can publish 

it on various popular platforms like YouTube, Facebook Ads, and Wistia.

Ludus 

You may want to create presentations that are heavily focused on designs. 

For such requirements, Ludus is the right app. Ludus can turn your slide-

show into artwork with its awesome features. It allows copying Sketch 

and Adobe Illustrator files and adds your personal font files. If you work 
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with SVG files, it will disassemble them for you and let you edit them. It 

comes with third-party integration features, and you can pull content and 

elements from platforms like Google Fonts, Figma, GIPHY, and YouTube 

to create stunning slides. The tool has advanced features like code blocks 

and gradients. You don’t have to be a pro designer to use it. You can use the 

guided tutorial of this app to use all the available features.

Emaze 
When you look at a well-designed presentation, you wish to have some 

designer skills to create a similar presentation. The good news is that you 

don’t need to be a seasoned designer to create amazing slides, you can do it 

using Emaze. It comes with hundreds of 2D and 3D templates that you can 

use to create your slides. Once you have selected the template, you can per-

sonalize it with features like animations, pan, zoom, sound effects, etc. You 

can access Emaze from any browser or device. You can open presentations 

created by this tool in MS PowerPoint too. Emaze is a free cloud-based app 

and it keeps your content safe with a top-notch security system. It supports 

importing PowerPoint and PDF files.

SlideLab 

It is a new but popular tool that you can use to create professional interac-

tive presentations. It has enhanced UI offers and offers you a powerful 

slide-making experience with a speedy workflow. All the elements you need 

will be available within two or three clicks with its easy-to-use editor. It is 

a free app that comes with real-time cloud sync, has a media library, and 

also lets you perform a quick media search on the Internet. Once you are 

done creating a presentation using SlideLab, you can export it in PDF and 

PPTX formats and run them on popular presentation tools like PowerPoint, 

Open Office, and KeyNote.

Conclusion
As explained above, Google Docs, Slides and Sheets are very helpful and 

filled with various features that would aid both individuals and organisa-

tions.  The features are exhaustive and if one knows what all they bring to 

the table, one can optimise the productivity. 

While there are a number of similar options available in the market, it 

would be very difficult to beat the ease and simplicity that Google Docs, 

Slides and Sheets offer. 
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Google 
Jamboard

G
oogle Jamboard is an interactive whiteboard that allows users to 

share ideas and images and collaborate. Each frame is called a 

Jam. So when it’s time to start a new screen, the app lets people join 

an existing screen or open a new Jam to start a presentation from 

scratch. However, you do not need a Google Jamboard to use the Jamboard app.  

 

What is a Google Jamboard - Hardware?
A Google Jamboard is a 55 inch whiteboard screen that connects to phones 

and tablets. Imagine you’re in a brainstorming meeting where some people 

are in the room, and others are connected remotely. The In-Room Jamboard 

Scribble, ideate, and execute 
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is available for participants to use as a traditional whiteboard but can also 

be projected into video meetings so remote participants can collaborate 

with people in the room.

How does Google Jamboard work?
There are two ways that Google Jamboard takes input from data written via 

pens. One way is to use the stylus as a pencil. The board shows the exact 

shape of the data you write in your handwriting, just like you can with paint.

Google’s Jamboard also 

acts as a mini browser. You 

must have used the Docs 

or Sheets search option. 

When we upload an image 

to Docs, you can upload it 

from Drive or the system; 

but you can also search 

for it directly on the web. 

But here, it goes to a whole 

new level.

What are the top features of the Google Jamboard app?
Everyone can collaborate on the jam anytime, anywhere; you can use your 

phone or tablet to join or open a Jam on a nearby board.

It has a toolbar that allows you to draw or write by imitating the strokes 

of a marker, a pen, a brush or a highlighter. In addition, it allows you to 

choose between six colours.

Google Jamboard has to undo and redo buttons, a clear frame button 

to return to the blank canvas, and a background button so that instead of 

a white canvas, we have a sheet with grids, stripes, dots, or blue or black 

background. a classic blackboard

 The Google Jamboard tool automatically saves what you do as another 

document in Google Drive, so you will have access to what we have written 

from any device with the Internet. If you want, it is also possible to share 

it through a link, like any other Google Drive document, and you can even 

save it in image or PDF format.

Google Jamboard also comes with two thick white stylus pens for drawing 

and another white, mouse-like device that acts like an eraser. The rolling 

stand is an additional accessory.
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Here’s a full spec rundown:
•	 55-inch 4K UHD display

•	 120Hz touch scan rate / 60Hz video refresh rate

•	 16-simultaneous touch points

•	 Handwriting and shape recognition

•	 Built-in tilt support / Built-in wide-angle camera

•	 Down-firing speakers / Built-in microphones

•	 NFC

•	 HDMI 2.0, USB Type C, 2 X USB 3.0

•	 SPDIF audio out

•	 Wi-Fi 802.11ac 2x2 / 1 Gigabyte Ethernet

•	 Google Cast

•	 2 x Fine tip passive stylus, Eraser, Microfiber cloth

 
Small businesses sometimes need to brainstorm on a whiteboard. But 

whiteboard brainstorming meetings don’t work when you have remote 

colleagues. To overcome this and other challenges, Google has designed a 

cloud-based digital whiteboard called Jamboard for Business.

How to use Google Jamboard from scratch?
Before explaining how to use Jamboard, we want to point out that we will 

focus on the free Jamboard, that is, on the tool you have available in your 

Google account.
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To start using the Jamboard collaborative whiteboard, you must first 

have a Google account. If you don’t have it yet, you can easily find it in 

the search engine. To use the hardware, you’ll need to upgrade to Google 

Workspace if you’re using an older free edition. In addition to having your 

account in this Google service, you need a hardware or mobile device such 

as a smartphone or tablet to use the service, although you will receive all 

the features on the 55-inch digital whiteboard.

You will also have the option to use it partially from your web browser 

since from the web itself, and you will be able to access many of its func-

tions and present what you have created. All the devices used will receive 

the information and the people with whom you share the information.
After creating your account, go to the main screen of your browser, and at 

the top right, below the list of platforms, you will find Google Jamboard. To 

speed up this process, bookmark jamboard.google.com and log in directly.

1. Create your jam
Within the Jamboard interactive whiteboard, we can see an overview of our 

“jams” (workspaces or whiteboards) that have been previously created. If 

you want to create a new one, at the bottom right, you can see the “+” button 

with which you will create a new whiteboard. An essential step of knowing 

what Jamboard is and how to master it in a matter of minutes!

Pressing the “+” button opens our new whiteboard in which we can 

change the title, and on the left side, we find the following tools:

•	 Pen: You can choose between a regular pencil, highlighter, brush or 

marker, and in the same way, you have colours. 
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•	 Eraser: Every creative process brings errors, but nothing difficult to fix 

with the eraser tool to modify or delete. 

•	 Selection: This option allows us to move the objects we place inside the 

Jamboard digital whiteboard. For example, when adding sticky notes, 

you can move them around or group them by colour. 

•	 Sticky notes: Google Jamboard gives us 6 post-it colours on which we 

can write data, ideas, etc. 

•	 Images: Add visual references to your Jamboard collaborative white-
board. You can upload them from your computer, Google Drive, or 

Google Image Search.

•	 Laser pointer: this option helps us point out the elements we want to 

comment on, modify or delete within our Google Jamboard.

It is noteworthy that you can do different things depending on where you 

connect. You can write and draw with the stylus, use the search engine and 

add websites or images, and drag and change the size of images and text.

2. Download a whiteboard
After filling out our Jamboard collaborative whiteboard, we can download 

it and store it on our device without any inconvenience, thanks to automatic 

saving in Drive. We recommend downloading it as a PDF file, and you can 

also make copies of the board or even delete it.
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3. Share your whiteboard
Now that you know what Jamboard is and how to create your presentations 

share your Google Jamboard with your team for online collaboration. Add 

each member’s emails and assign them a role (editor or view only), or if 

you’re looking for mass participation, share the link with them. 

And is there a Jamboard app for PC? Yes, it is a Google Chrome exten-

sion that can be downloaded from the web browser to have direct access 

and make your “jams” online. You can also download it for your Android 

or Apple iOS devices and use it in your daily activities.

4. Put a custom background on Jamboard.
Adding custom background to your Google Jamboard frame is a very simple 

process. Click the “Set Background” option on the Jamboard platform. 

Then, select the image option and choose your file. You can choose to upload 

an image (we recommend using a size of 1920 x 1080 px for best results), 

take a photo with your webcam, do a Google Image search, or use an image 

from Google Photos. Please note that adding a custom background in Google 

Jamboard is currently only available on the web. 

How to Use Jamboard in Google Classroom?
It is not only necessary to know what Jamboard is and its great benefits 

but also to know how to use it in the various Google tools. One is Google 

Classroom, which integrates very well with the Jamboard platform.

The collaboration between both tools facilitates online learning very 

easily. For example, teachers can share a Jam as an assignment in Classroom, 

allowing students to collaborate or work independently on it just like any 

other Google file. 
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If you want to share your jam from the app as a PDF, open the jam you 

want to share, tap the More icon, and then tap Share Jam as PDF. From 

there, select how you want to share the PDF file. To share a specific frame 

as a PNG file from the app, tap More > Share this frame as an image and 

follow the on-screen instructions.

How to use Jamboard on mobile?
Get started by visiting the Jamboard desktop site at jamboard. google.com 

or by installing the Jamboard app for Android or iOS.

Sign in to a Google account and start by selecting or tapping the Plus icon 

to create a new Jam. When you create a new jam, it is automatically saved 

to your account. To see the version history of a Jam, view it on a computer. 

Open the jam, and select More > View version history.

How to use a whiteboard during a video call in Google Meet?
To be able to use this tool in the middle of a video call, you just have to 

follow these simple steps:

1.	 Start or join a video call, preferably through a computer.

2.	 Locate in the lower right corner of the screen an icon with a small tri-

angle, square and circle that represents the Activities menu. Click on it 

and then select Use whiteboard.

3.	 In this step, there are two options to choose from:

4.	 Create a new Jamboard: Click on the Start a new board option.

5.	 Open an old Jamboard: This option allows you to load a board hosted in 

the cloud or on the computer. To access it, just click on Choose in Drive.

Conclusion
There is no doubt that the Jamboard collaborative whiteboard offers a wide 

panorama for all kinds of activities regardless of the field, and you can 

even use it in your video calls through Google Meet. Today, educational 

institutions are looking for resources that help in their pedagogical pro-

cesses, encouraging students to learn, collaborate and participate. In any 

learning environment, it is important that each student feels engaged.  So, 

be it business meetings or a classroom, Google Jamboard is an effective tool 

to have at your disposal. 
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Google Sites

G
oogle Sites is a platform for creating and hosting websites, accessible 

for free, even if integrated with G Suite and offers the possibility of 

creating simple and professional sites very quickly, without prior 

knowledge. It also offers many themes and templates, which inte-

grate perfectly with other Google tools, such as Sheets or Drive. The collaborative 

aspect is therefore important for this solution, which goes beyond the simple 

creation of websites since it is also linked to other G Suite services.

You can create sites with this Google application without using HTML code 

and with a few simple clicks. The use of Google Sites is very intuitive because 

many models depend on the desired activity. It is possible to quickly and easily 

create a basic site, whether for a personal blog, an association, or a school, then 

to personalize it as you go along according to your tastes. The speed with which 

it is thus possible to create a site is impressive. Furthermore, Google sites have 

added several other updates that have made it easier for people to make a website. 

Quite simply, when you first hear what Google Sites is, you understand that it is 

a tool that can be useful if you need to create something quick and minimalist. 

Register your presence on the web
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For example, a small platform to communicate with your team members or 

share content with your clients. 

Features of Google Sites
•	 No limit to the number 

of websites: There is no 

limit to the number of 

websites you can create 

as long as you stay within 

your Google account’s 

15GB storage limit. This 

is completely free. 

•	 Easily manage the plat-
form: easy creation of web 

pages in Google Sites.

•	 Customize the interface of a web page: Google Sites has pre-designed themes.

•	 Use multimedia files: audios, videos, presentations, documents, etc.

•	 Manage projects: share Google Sites with your team to assign tasks.

•	 Create different sites: Google Sites New allows you to create intranets, pages 

for your collaborators, projects, and more.

•	 Site Templates: Quickly and easily create high-quality sites optimized for 

common uses. 

•	 Announcement Banners: Highlight important information to ensure site 

visitors see time-sensitive updates. 

•	 Family Link Account Access: Allows Family Link-managed Google accounts 

users to view and edit sites.

Google Sites is often overlooked as a website builder, but it’s a very powerful 

and flexible tool. With its simple drag-and-drop interface, you can easily create 

a professional-looking website without any HTML or coding knowledge. Plus, 

since it’s part of the Google suite of products, you can easily integrate other 

Google tools like Calendar, Drive, and Forms into your website. And best of all, 

it’s completely free!

How to use Google Sites?
Start creating a website by going to the official Google Sites site, which will 

automatically open the home screen (like the one above) for you to create a new 

blank project or choose from the various available templates. You can also launch 

from Google Drive>New>More> Google Sites.



57Google Sites    Google Sites

When you start a blank site, you will immediately see the edit screen for 

the main page.

At the top, you can change the page title (every page of a website has a 

name), which will be automatically saved to your Google Drive cloud.  In the 

large box is the option to edit the page title, add the website name (minimum 

2 pages to appear) and change the background image to one stored on your 

computer or choose one on the web. You can increase the pages that will make 

up your site (such as Contact, Sales, Galleries, Videos, Company Blog, or 

whatever you can think of) by clicking on the + sign in the lower right corner, 

in the form of a button.

Above the plus sign is the main “Insert” toolbar, with options to add text 

boxes, images from storage or the Internet, embed content from other sites via 

HTML code, and import content from Drive.

How to change the appearance of a site?
Google Sites allows site owners to change the overall appearance of their site.

The ability to change the appearance of a site falls into three main areas:

•	 themes,

•	 site design,

•	 colors and fonts.

Changes to these areas can be made via the More Actions -> Manage Site menu.

Themes are combinations of site layouts, colours, and images we have pre-

configured for you. Once you’ve chosen a theme, you can change specific values ​​

such as background colors and images through the “Colors and Fonts” section. 
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When you change themes, 

what you have previously 

changed is discarded.

The “Site Design” sec-

tion allows you to manage 

features that appear on each 

site page. You can change the 

logo and change the location 

of the sidebar. Additionally, 

you can add, remove, and update sidebar elements like text boxes, navigation, 

and countdowns.

The “Colors and Fonts” section allows you to control a wide and varied 

selection of different areas of the site that you can customize with the colour you 

want. This section provides a “real-time” preview of changes as you make them.

Include HTML, Javascript, and CSS code in Google Sites
It is now possible to include HTML, Javascript and CSS code in Google Sites 

through the HTML Box tool in the following way:

•	  Go to the Google Sites page where you would like to embed the elements.

•	 Go to the Insert menu and select HTML Box.

•	 Add the HTML , CSS and /or JavaScript code.

•	 Once finished, click Save.

•	 To preview the embed code, click Save on the Google Sites web page 

you’re editing.

To ensure the code is error-free, errors will be shown underlined red as you type.

How to manage attachments on a Google Site?
You can manage site attachments by clicking the “More Actions” dropdown 

menu and “Manage Site.” In the “Attachments” section, you will have the option 

to edit and control attachments. Editing options include:

•	 renaming files,

•	 file scrolling,

•	 file deletion,

•	 file substitution.

To successfully download, view, or access attachments, you need to ensure 

that the end-user is directly viewing the page on which the attachment is hosted.

Directly copying and pasting the URL of the attachment doesn’t work. 
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How to set up a landing 
page for a Google site?
To set your site’s landing 

page, click the More actions 

menu and select Manage 

site. Once there, click on the 

General tab, where you will 

see the area to indicate the 

landing page. Just choose another page (default is “/home”) and click “Save 

Changes”. Please note that you cannot delete a page that has been marked as 

a landing page.

How do I change the order of the pages on a Google Site?
You can change the order of the pages in the navigation menu in two ways.Go to 

“More Actions -> Manage Site -> Site Appearance -> Site Presentation” and click 

“Edit” next to “Navigation” (in the “Sidebar” section). Next, select the page to be 

moved and use the arrows to scroll it up or down. When you’re done, click “OK.”  

The other way is:

•	 Click on the page you want to move to.

•	 Select the “More Actions” button.

•	 Click “Move” in the dropdown menu.

•	 Click where you want to move the page.

•	 Click the “Move” button at the bottom of the screen.
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Note: Ensure you’ve unchecked the box next to “Automatically organize 

my browsing.”

How to embed Calendars & Maps in Google Sites?
Embedding your Google Calendar on a site to share with your colleagues, 

friends, or family is easy.

You will first need to click the “ Edit Page “ button to enter the editor view, 

click the “ Insert “ menu and then select “ Calendar “ from the dropdown list. 

Then select the calendar from your list of calendars and click the “ Select “ 

button. Select the options that Calendar offers, and when you finish making any 

changes, click “ Save “, and your calendar will be added to your site. Click “ Save 

“ again, and your calendar will be successfully inserted into your Google Site.

You must ensure that your calendar is shared with the people who will have 

access to your site; another way would be to configure the calendar with the 

public view. Embedding a Google Map on a site to share with your colleagues, 

friends, or family is easy. First, click the “ Edit Page “ button to enter the editor 

view, click the “ Insert “ menu and select “ Map “ from the dropdown list. This 

will open a Map box. In the map, the browser type the address or map location 

you want to find. Click “Search”, and your map will appear. The Red mark 

indicates the location of the place you are looking for. Within the map, there are 

three options: Map, Satellite or hybrid; select the one you want to use and click 

on “ Select “when finished. Now you can customize the options Maps offers or 

just leave them as default.
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Click on “ Save”, and your map will be added to your site; you could also 

choose the alignment inside the page “Left, centre or right” when finished, click 

the “ Save “ button that appears in the right corner, and your map will appear 

inside of your Google Site.

How to make the most out of your Google Site?
There are a lot of things you can do with your Google Site, but here are some 

tips to make the most out of it:

1. 	 Use the “announcements” feature to keep your visitors updated on what’s 

new on your site. For instance, if you’ve just added a new page or updated 

some content, you can post an announcement, so everyone knows.

2. 	 Use the “comments” feature to encourage interaction with your visitors. 

This is a great way to get feedback on your site or start a discussion about 

something relevant to your niche.

3. 	 Use the “search” feature to help visitors find what they’re looking for on your 

site. This is especially helpful if you have a lot of content on your site.

4. 	 Use the “RSS Feeds” feature to syndicate your content and make it available 

to other people who might be interested in it. This is a great way to get more 

exposure for your site.

5. 	 Take advantage of the “pages” feature to create different sections on your 

site and organize your content to make it easier for visitors to navigate. For 

instance, you could have a page for articles, a page for products, and a page 

for contact information.

Conclusion
Google Sites is an easy-to-use website-building platform that allows you to 

quickly create and publish new sites. While it can’t compete with some of 

the more in-depth, paid, and free alternatives like Squarespace or Wix, it’s a 

great way to get your website up and running without professional design and 

development expenses.

If you’re looking for an easy way to build a website, Google Sites is worth 

checking out. 
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Google Forms

D
ata is everything in these days, and not many people depend on 

paper forms to acquire it. It all comes down to online forms for 

conducting most surveys. As usual, Google saw a market need and 

responded with an inventive solution. Yes, you are correct! We’re 

talking about Google Forms here.

Google Forms is a free-form builder tool that allows all of its users to easily 

construct basic to even complicated questionnaires and surveys online to gather 

and organize the information. It can be treated as a survey administration soft-

ware that is part of the Google Docs Editors package. Google Forms can only be 

accessed using a web browser. 

These forms may be used for various purposes such as planning events, 

managing registrations, generating a poll, gathering contact information, and 

more. Users may even export all collected data to a spreadsheet and then examine 

it in Google Sheets.

Answers to questions left unanswered
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What are the main benefits of using Google Forms?
The following mentioned points are the major benefits of using Google Forms:

•	 It is free software available online that allows you to rapidly and efficiently 

collect information.

•	 With each new question, you may include multimedia such as photographs 

or YouTube videos, as well as written explanations that provide suggestions 

or elaborate on your query.

•	 All you need is a Google account to use this tool, the same one you use to 

access Gmail, YouTube, and Google Drive.

•	 The UI is simple to use. It allows any user with basic internet knowledge 

to create forms.

•	 You can build surveys with Google Forms in minutes to ask your clients or 

collaborators questions about your products or services.

•	 At the design level, you can even select from a colour palette or use your own 

photographs as a background.

•	 Google forms save the input we receive so that we may study it in depth.

•	 We can access the spreadsheet view of Google spreadsheets since they 

are connected.

Using templates
When you see the phrase template, it simply refers to an example document with 

certain features already in place. You may either add additional information, 

remove it, or alter it. The user may also easily save and manage the outcome as a 
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standard word processing document. By not having to start from scratch, using 

form templates saves time. Google Forms templates allow users to simply add 

or delete parts and make changes.

Follow the steps below to gain access to Google Form templates:

•	 Login to your Google account using Gmail and password.

•	 Then, navigate to Google Forms.

•	 Select Template Gallery.

•	 From here you can access the whole template gallery, which is divided into 

Education, Personal, and Work categories.

Some of the widely used templates are being mentioned below:

1. Contact Forms
Contact forms are one of the most basic and extensively used methods for col-

lecting website users’ contact information.  It is very easy to create a contact 

form using Google’s form template. 

2. Event Registration
To create an event registration form, begin by visiting Google Forms and selecting 
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the Event Registration template. Some of the questions on the Google Form 

template may or may not be relevant to your event. You can, simply modify it.

3. Event Feedback Survey
It is useful to know how happy attendees were after an event in order to make 

adjustments for future events.

4. Order Forms
Businesses use order forms when acquiring goods or services from third-party 

vendors to verify that they receive exactly what they wanted. Automatically, 

you get questions like: 

•	 Are you a new or returning client?

•	 Enter the item’s product number to order it.

5. Customer Feedback
It is critical to maintain your consumers satisfied and happy if you want your 

business to prosper. Customer feedback forms offer businesses the ready-made 

template to collect the best versions of feedback from their customers. 

How to create a form?
Here is a step-by-step guide for you all about how you can easily create a form 

using Google Forms. 

Part 1: Creating a new Google Form
Step 1: First and foremost, you must go to the forms.google.com website.
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Step 2: The first item in the top-left corner is a plus sign with the label ‘Blank.’  

Select the Blank Plus option.

Step 3: A new form will be shown.

Note: You may also use Google Drive to build a form directly from Google Drive. 

You only need to follow these basic steps:

•	 Navigate to drive.google.com on a PC.

•	 Click New in the upper left corner, and then click on the options Google Forms.

Part 2: Editing your form
You may add and change up to 300 pieces of information, such as questions, 

descriptions, photographs, and videos, once you’ve created a form. You may 

also add up to 75 sections to your form to organise it by topic. In your Google 

Form, you have many choices for adding/editing data.

Symbols and their representations
•	 A circle with a + symbol indicates the addition of a new question.

•	 Arrow on paper: Import questions from a different source (such as another 

Google Form you created).

•	 A large and little T: Include a text box with a title and description that does 

not include a question, such as offering further context.



67Google Forms    Google Forms

•	 A square with two little triangles: Include an image in a new question.

•	 A rectangle having one symbol of a triangle inside: Insert a new question 

with a video.

•	 Two parallel rectangles: Create a new section in the survey to distinguish 

it from the others.

Add a New Question
1.	 Open a Google Forms form and click the + sign that represents the 

Add question.

2.	 Choose the sort of question you want to add from the right of the question title.

Types of answering options available:

1.	 Short answer: A one-line response that must be entered.

2.	 A paragraph-length response that must be written in.

3.	 Checkboxes allow respondents to choose numerous answers from a list.

4.	 Multiple choice: The respondents are provided with several options, but 

only one is accurate.

5.	 File upload: You must answer the question by uploading an external file, 

such as a document or a picture.

6.	 Dropdown: The right answer must be chosen from a list of possibilities 

in a dropdown menu.

7.	 Linear scale: In a customer service survey, the respondent replies by 

picking a point on a quantitative or qualitative scale.

8.	 There are several options. grid: The respondent must select responses 

from a grid and combine them.

9.	 A checkbox grid allows the respondent to choose numerous responses 

from a grid.

10.	Date: For entering a precise date

11.	 Time: For entering precise time.

3. 	 Fill in the blanks with probable answers to your query. Turn on Required 

to prevent individuals from not responding.

Add a picture or a video to a question or response.
Aside from questions, you can even easily add a picture to a multiple-choice or 

check box question or response. Follow the steps mentioned below:

1.	 Open a form in Google Forms and select a question or response.

2.	 Click the Add picture/Insert image icon on the right.

3.	 Upload or choose a picture.

4.	 Click the Select button.
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Add a section.
When making a Google form, readability is an important element to consider. 

Your audience should understand and easily read what you’re asking. Use 

sections to do this. Sections might help your form be easier to understand and 

fill out. Follow the steps mentioned below:

1.	 Open a form in Google Forms.

2.	 Click the Add Section button.

3.	 Give the new section a name.

Duplicate a question
Follow the steps mentioned below:

1.	 Select a question or a picture.

2.	 Select Duplicate.

Re-using any question from any previous Google Form
1.	 Open a form in Google Forms.

2.	 Click Add question on the right > Import questions.

3.	 Select the form containing the questions you wish to import.

4.	 Click the box next to each question you wish to add on the right.

5.	 Click the Import Questions button.

How can you make a quiz or covert a form into a quiz in Google Forms?
Step 1: To begin, navigate to the Google Forms link and select Open Forms.
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Step 2: Open a form and then click the Settings button at the top.

Step 3: Select the option to Make this a quiz.

Step 4: You must now personalise the quiz.

•	 Give a title/name to the quiz: Choose a title for your quiz form. Go to the 

section directly above the questions and form description, select Untitled 

form, and then give it a name.

•	 Include a description: Just below the quiz title, you need to fill up the blanks 

with the descriptive text of the quiz.

•	 Change the theme, background colour, or font style by adding a header: 

Select your selections by clicking Customize Theme.

•	 Transfer your form to a new Drive folder: Click Move to folder and then 

select your folder before clicking Move here.

Alternatives of Google Forms
There are many new rivals which have come up in the market, giving a 

tough competition to Google Forms. Some of them are mentioned below: 

1. WPForms
WPForms is Google Forms’ main rival. This option allows you to construct 

forms from templates, simply change the forms, and receive email notifications 

in real-time. It also has a drag-and-drop form builder to make your life simpler. 

In a nutshell, it is user-friendly and is utilised by more than 5 million(+) websites. 

2. SurveyMonkey
Although not as open-ended as Google Forms, SurveyMonkey is far superior for 

gathering user, employee, or customer feedback and making sense of the data. 

Many of the capabilities are comparable to those found in other form builders, 

and you may start creating surveys with up to ten questions for free.

3. Formidable Forms
The next Google Forms option on our list is Formidable Forms. It is yet another 

really powerful tool that is an enhanced version of the WordPress form builder. 

It has a drag-and-drop builder, making it extremely simple for anybody to 

construct various sorts of forms. You may create polls and surveys, payment 

forms, quizzes, and contact forms, among other things. The Basic package of 

Formidable Forms costs $39.50 per year. The forms are mobile-friendly. There 

is also the possibility to change the form HTML and apply conditional logic to 

display form fields depending on the user’s responses. You also receive a unique 
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tool that lets visitors make computations. When it comes to interactive form 

design, their sophisticated capabilities are simply unparalleled.

4. TypeForm
Typeform is an excellent tool for creating forms for your website. It’s loaded 

with functionality and allows users to develop various sorts of web forms. 

To get started, there are numerous form templates to choose from, including 

quizzes,  questionnaires, surveys, polls, giveaways, lead generation, and others.

5. Microsoft Forms
Check out Microsoft Forms if you’re looking for a Google Forms alternative that 

allows you to utilise Excel instead of Google Sheets. It’s Microsoft’s answer to 

Google Forms for online form data collecting. It is quite simple to use. The visual 

drag-and-drop builder allows you to easily create forms.

Conclusion
You may be wondering if Google Forms has any drawbacks. “No,” is the short 

response. Unless you have a specific affinity to another survey-creation tool or 

are anti-Google, Google Forms is the best way to go because it is free. It boasts a 

wide range of functionality, making it a must-have tool for everyone. 
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Lumin PDF

P
ortable Document Format or PDFs are unique because all kinds of 

official documents, such as reports, online magazines or resumes, 

use them to present their final product. But, they have a downside 

– they come in read-only format, meaning you cannot edit them 

directly. As a solution, some tools available in the market are used to convert 

PDFs to another format, such as .docx, that is later used for editing purposes. 

But that process is highly time-consuming, and the editing process is some-

times not done well because the conversion process damages the document 

structure. In order to counter this drawback, we need some applications 

that allow direct editing of pdf documents, and one such app is Lumin PDF.

Why should you use Lumin PDF?
We have discussed the need for an application that would enable editing in 

PDF format, but one might wonder why we should choose this application 

and not others?

PDFs all along!
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The answer lies in its amazing integration of features. Apart from editing, it 

also provides real-time syncing, meaning that all modifications, whether done 

by you or your collaborators, will be automatically saved into the cloud and will 

be accessible on all devices and platforms. 

This was just basic information about the features. Following are the features 

of Lumin PDF, explained in depth.

•	 Editing: With Lumin PDF, you can do basic editing such as highlighting, 

underlining or striking out text. Additionally, you can add images and 

shapes and add comments or tag your team members to know the latest 

instructions on the project.

•	 Document formatting: You can add, delete, merge, and crop pages in just 

a few clicks with this app.

•	 E-Signature: You can easily put your signature anywhere in a pdf document 

without the hassle of printing and scanning.

•	 Connection with Google suite: Lumin PDF can be connected with Google 

Docs, Google Drive, Google Workspace, Google Classroom, and Dropbox.

•	 Huge storage capability: Lumin PDF can be connected with Google Docs, 

Google Drive, Google Workspace, Google Classroom, and Dropbox to store 

and access a large number of PDFs.

An incredibly useful feature 

of Lumin PDF is that it can be 

connected with most of the 

Google suite apps. 

How to sync a PDF file in 
Google Drive to Lumin 
PDF?
A prerequisite: You use Google 

Drive with all your pdf files 

being already uploaded on the same. Also, if you have multiple Google accounts, 

then make sure you use the account you wish to work with Lumin PDF. More-

over, upload the pdfs you want to load on Google Drive working on that Google 

account. After doing all this, follow the steps below:

1. 	 Open Google Drive either via app or on your browser.

2.	 Go to the main menu of your Google Drive.

3.	 Click “New”.

3. 	 Click “More” from the menu.
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4. 	 Click “Connect more apps”.

5.	 Enter Lumin in the search bar.

6.	 Click Install to add the Lumin PDF Google extension.

How to sync Google Classroom to Lumin PDF?
Both Google Classroom and Lumin PDF are synced to Google Drive. Therefore, 

to connect and sync Google Classroom to Lumin PDF, you must first install 

the Lumin PDF extension on your Google Drive. Then Google Classroom 

will be automatically synced 

to Lumin PDF. 

If you have not synced 

Lumin PDF to Google Class-

room, do that first. You can 

follow the steps mentioned in 

the “How to sync a PDF file in 

Google Drive to Lumin PDF?” 

part of this book.

 
OCR,  Conversion, 
Unlocking, Compression, 
and Split and Merge
Apart from the basic editing 

tools such as highlighting, 

markup, etc., Lumin PDF 

offers some advanced fea-

tures in the Lumin Toolbar, as 

discussed below.
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1. Optical Character Recognition: 
Optical character recognition, or OCR, is one of the most helpful features of 

Lumin PDF. It allows one to scan and recognise text in any PDF, image and photo, 

search and find any PDF file in Lumin PDF. Using OCR, you can do annotations 

in the converted file that has been converted into readable text form, thereby 

reducing your precious time and energy.

2. Conversion
Lumin PDF provides a feature to convert various file formats such as Word, 

PowerPoint and JPG to PDF in just a few clicks. The benefit is that you can edit 

it in a PDF file only.

3. Unlocking
Lumin PDF offers security to your PDF file via its feature of setting a password. 

In addition, you can unlock the file in case the password is forgotten and edit 

it after securing it. But, you need to unlock it to edit it and lock it if you want to 

set a password again.

4. Compression
It is a common experience that we need to attach a PDF document via email 

or upload a document in a form, and the file has a size limit, not accepting our 

large-sized files. Lumin PDF’s “compress PDF” feature handles this quickly. 

The major advantage of using the app is that it does not convert PDF files to 

ZIP files, reducing the chances of corrupting that file. Moreover, you can edit 

the PDF file in the process.

5. Split and Merge
It is common to have some pages in a PDF document in the wrong order, needing 

to be cropped, deleted or rotated. Moreover, you can insert a blank page or delete 

a page, which is very common in PDF files. All these can be done by Lumin’s 

Split/Merge tool. A time-saving advantage of using Lumin PDF for this is that 

you are not restricted to uploading one page at a time. You can upload numerous 

pages in an instant.

6. E-Sign
 Most contracts have an everlasting requirement of putting a signature. Earlier, 

it took a lot of time just to sign a document and send it because firstly, one needs 

to take a printout, sign it and scan it, convert and finally send it. In recent times, 

most contracts are in PDF format, so there is a need for a tool that can digitally put 
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your signature in the PDF. E-Sign is such an application. Lumin PDF provides 

an E-Sign tool that does it pretty well.

How to add comments in Lumin PDF?
 In addition to adding comments in a PDF file, Lumin PDF also allows you to 

add replies to the comments. 

To add a comment, follow the steps below:

1.	 Go to the toolbar and select the comment option.

2.	 Select the part on the PDF file where you wish to add a comment. On doing 

this, a comment icon appears on the selected part with a text entry box.

3. 	 Type your comment and click comment.
If you wish to edit, delete or change the icon colour of the comment box, 

click three dots on the right of the comment entry box and set the desired as 

per your preferences.

How to reply to comments on Lumin PDF?
We earlier discussed that the application enables replying to a comment. To do 

so, follow the steps as shown.

1. 	 Click on the comment to which you want to reply. On doing this, a reply 

field appears.

2. 	 Type your reply in the reply field.

3. 	 Click the two-tick icon next to the three dots icon in order to resolve 

the comment.

You can view and edit all the comments in a PDF file using the comment 

history in the toolbar.

What are the alternatives to Lumin PDF?
There are many alternatives to Lumin PDF. Many applications serve the same 

functionalities as Lumin PDF. Then why should we choose Lumin PDF? This 

is a valid question and the answer lies in comparing it against its popular rivals 

for all the provided features. There are many such companies, in which the most 

popular ones are DocHub, Kami, DocuSign, Sejda PDF editor, SignRequest, 

ProProfs Knowledge-based software, Kloudio, and Adobe Acrobat. There are 

some features in which users have reported the alternative app to have an edge 

over Lumin PDF.

On comparing the reviews of DocHub and Lumin PDF, customers have given 

a better rating on DocHub for the ease of doing business. But in all remaining 

criteria, Lumin had better rankings.
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In addition, on comparing Lumin PDF with Kami, customers rated Kami 

more for meeting their requirements and positive direction (improving their 

product). Whereas, on comparing with Sejda PDF editor, the customers rated 

Sejda more for its ease of use and the list of features provided by it. On the other 

hand, lumin PDF was rated for ease of support and features, etc. G Tasks is 

another alternative considered easier to set up and highly usable, with SignRe-

quest another such application that meets meeting requirements well.

Lumin PDF’s unique feature is its combination of tools varying from annota-

tion, comment, and e-sign to OCR and locking PDFs. There are very few apps 

that provide all these features in one place. This feature makes Lumin PDF better 

than most and at par with its rivals. It can be called the one-stop solution for all 

PDFs for doing almost anything. 
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Other Apps in 
Workspace

Google Meet
Google Meet is another Google service that is widely used by individuals and 

businesses for audio and video conferencing. A major benefit of using Google 

Meet is that there is no software to install. In order to participate in the call, both 

organizers and attendees can use a modern web browser.

Features
Below are some top features of Google Meet:

•	 Unlimited meetings: You can set up an unlimited number of meetings to 

connect with your coworkers, classmates, and clients. You can invite up to 

100 participants to the meeting at no cost.

•	 Live captioning during a meeting: You get an option of automated live 

Show me what you’ve got!
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captions powered by Google’s speech recognition technology. Click on the 

three dots on the Meet screen to bring up the option to enable live captions.

•	 Works on all devices: It works on any device. You can join or organize a 

meeting on your desktop, Android and iPhone. If you are working from 

home, you can join a meeting from Google Nest Hub Max.

•	 Adjustable layouts and screen settings: The service automatically switches 

the layout in a video meeting to display the move active participants and 

content. Click the three dots in the lower corner of the Meet screen to switch 

the layout.

•	 Video and audio preview screen: When you click on the meeting link, 

you get the option to adjust your mic and camera and see how you will 

look before entering the meeting. You also get a preview of who has already 

joined the meeting.

•	 Controls in the meeting: Anyone can easily mute, pin, or remove participants. 

For education accounts, only the meeting creator can mute or remove others.

•	 Screen Sharing: You can present your entire screen or an application window 

to collaborate on documents or share presentations.

•	 Messaging: During the live call, you can share files, links, and other messages 

with participants and make your meeting more engaging. Click the chat icon 

to share files, links, and other messages with participants. Messages are only 

available during the meeting.

Alternatives to Google Meet
•	 Intermedia AnyMeeting: The service provides web-based video confer-
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encing software designed and is useful for small businesses. With Any-

Meeting, you have access to a variety of tools to host webinars, video con-

ferences, and online meetings complete with screen sharing capabilities. 

It is not free if you want to have more participants in your meeting, unlike 

Google Meet.

•	 Dialpad Meetings: It is another web conferencing platform with document 

management capability that integrates with third-party applications such 

as Google Drive, LinkedIn, Evernote, and Dropbox. It includes features such 

as screen call controls, sharing, call recording, and a mobile application. It 

has a free plan for individuals, and businesses can use it by paying a fee.

•	 Zoom: It is a unified communications platform primarily known for its use 

as a web conferencing tool. It features collaboration tools, HD video and 

audio, chat functionality, and an enterprise cloud phone system. The basic 

version with limited participants and call duration is free. You can also opt 

for a paid version depending on your requirement.

•	 Zoho Meeting: Zoho Meeting is a secure online meeting platform that helps 

you find new ways to collaborate and work remotely with efficiency. It helps 

you enhance your remote collaboration experience as it is highly secure. 

With the free version, you can invite 100 participants and host 100 meetings 

but only for 60 minutes. For a longer duration, you need to buy a paid plan 

which comes at reasonable rates.

•	 Whereby: It is a video conferencing platform useful for small teams and 

comes both in a free edition hosting up to 4 guests simultaneously in a ses-
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sion or a paid edition that supports up to 12 simultaneous meeting guests, 

among other features. The meeting recording process is manual, and you 

don’t have the option to work on that.

Google Hangouts and Chat
Google Hangouts is now being replaced with Google Chat for everyone. For some, 

it may have already been removed, and you may not be able to access Google’s 

Hangouts feature. If you are unable to use your existing Google Hangouts app, 

you can use Google Chat.  Google 

Chat allows you to do more with 

messaging - you can react to 

messages with emojis and save 

time by using smart replies. If 

you want to use the video calling 

feature under Google Chat - it is 

only available on mobile devices.

Using Google Chat on 
Different devices 
Follow the below steps to access 

Google Chat on your Android & 

iPhone devices:

•	 Open the Gmail app.

•	 At the top left, tap the Menu option and then go to Settings.

•	 Choose an account to opt into Google Chat.

•	 Under ‘General’, next to ‘Chat’, turn on Show the chat and spaces tab.

Follow the below steps to access Google Chat on your computer:

•	 On your computer, open Gmail.

•	 At the top right, click Settings and then see all settings.

•	 At the top, click Chat and Meet.

•	 Click Google Chat and then Save Changes.

 
Key features of Google Chat
•	 Messaging and Group Collaboration: You can send direct messages in 

a group conversation. Google Chat helps teams collaborate fluidly and 

efficiently from anywhere. You can securely connect with anyone with 

whom you work, and take group work to the next level with shared chat, 

tasks, and files.
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•	 All messages in one place: You can use 

Chat straight from Gmail, or as a stan-

dalone app. It comes with seamlessly 

integrated tools that keep track of all your 

work communications and choose the right 

channel for every conversation.

•	 Collaborate in dedicated Spaces: Spaces 

are the central place for teams to engage 

in topic-based discussions, move projects 

forward, share knowledge and ideas, and 

build communities and team culture.

•	 Make use of bots: You can integrate both 

Google and third-party apps like Salesforce 

and Jira – to keep all of your notifications in 

one place. Also, use bots to automate simple 

tasks to focus on what matters.

•	 Data Protection: Google Chat comes with a secure-by-design infrastructure, 

global network, and built-in protection. These are used by Google to secure 

your information and safeguard your privacy. Google encrypts your data 

in transit and at rest, and its array of default-on anti-abuse measures helps 

to keep every organization safe.

Alternatives to Google Chat
Hangouts and Chat are not the available options for Video conferencing and 

chats. Many tools are available that help you stay connected with your friends 

and colleagues. Some of the alternatives are:

•	 Flock: It is built for communicating with your colleagues like Google Hang-

outs. However, it is not only about chat and video conferencing - there is more 

to it. You can use tools like Asana, Google Calendar, etc with Flock. Unlike 

Hangouts, it has built-in audio and video conferencing. Also, you have an 

option to leave an audio message on any channel. It is free for small teams, 

while midsize teams and large enterprises can enroll under the paid version.

•	 Slack: One of the most popular chat software for businesses. It works as a 

central hub for all your business communication needs. Using Slack, you 

can easily navigate multiple conversations at all times with easy-to-find 

channels and the ability to join multiple Slack teams with a single login. 

Slack’s video functionality works only for 1:1 chats. It is not built for video 

conferencing with more participants.
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•	 Discord: You can use Discord to play tabletop games, hold a weekly vir-

tual meeting and live stream movies and documentaries and watch with 

your friends. It has some unique features like set roles for individual users 

where a particular action can only be performed by a user to whom the role 

is assigned.

•	 Telegram: It is one of the fastest-growing messaging apps that allows you 

to share videos, gifs, documents, geo-location, and images. Its secret-chat 

feature is encrypted end-to-end with a self-destruct mechanism that deletes 

messages after a set period of time from one second to one week. The normal 

chat option is not encrypted. So if you are looking for a secure communica-

tion tool for your business, Telegram may not be the right choice for you. Its 

new profile video feature is a standout that may become the standard across 

messaging platforms. To sum up, Telegram is best for nonprofessional teams 

or small working groups.

•	 Facebook Messenger: The app is used by more than a billion people world-

wide. It is easy for businesses and working groups to pick up because of its 

ubiquity - everyone already has the app. Messenger lets you share images 

and files with no compression, and allows for 1:1 and group video calling. 

Messenger can act as an all-in-one communication and Enterprise Social 

Networking tool for you. Facebook Messenger is free for all Facebook users. 

For additional features like unlimited groups, unlimited file storage, an org 

chart, and custom integrations, Facebook Workplace charges you a fee.

Google Currents
Previously known as Google+ for G Suite, Google Currents is a tool developed 
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by Google to support internal enterprise communication within the enterprise. 

It is one of many products that make up the Google Workspace line of products.  

Basically, Google Currents is Google+ rebranded. Rather than targeting indi-

viduals, it targets enterprise users, which is a smart move given the industry’s 

current saturation. The UX for Google Currents is almost similar to Google+ 

layout, hence it does look and feel very familiar. Currents runs on tags, just 

like Google+ did. However, the bigger takeaway here is providing aid to inter-

company communication between employees and collaborators. Hence, in this 

way, Currents is a bit like a social networking version of Slack and Teams. You 

can use Google Currents to:

•	 Using Currents, leaders and employees can exchange ideas across their 

organization and gather valuable feedback without overusing their inboxes.

•	 Posts from upper level of management can be given priority in the 

home stream, thus improvising visibility across the organization and 

driving alignment.

•	 Users can easily attach attachments and tag their posts in Currents, which 

offers a seamless experience for composing content.

•	 Content stays on Currents over time, which enables users to revisit and 

engage whenever they like.

•	 Admins have the ability to delegate content management responsibilities to 

a new role called Content Administrator.
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Features of Google Currents
•	 Streams – Streams are all the latest posts, updates, and content which can 

be stored. Inside Streams, you will find department-wide news, unread 

posts, and essential updates from admins. Streams is very similar to your 

Facebook profile’s homepage. All of the content is curated and stored here, 

which you can access whenever you want.

•	 Tags – Tags form an important part of how Google Currents functions. 

Tags are used to give level of relevance to posts and updates. It will enable 

companies to manage content more easily and ensure the entire workforce 

is on the same page by creating their own, bespoke tags.

•	 Types of Post – Currents supports a wide range of post types. You can do 

the following things from the compose window: Post titles, Add links to text, 

Use text formatting options, Add Google Drive files such as presentations, 

documents, spreadsheets, and Insert topical tags.

What are the alternatives to google currents?
Google isn’t the first company that introduced a company-based networking 

site. There are many more alternatives to it. There are many more platforms 

that Google Currents Alternates to. Few of them are:

 
1. Workplace By Facebook
Obviously, the first on this list and the biggest alternative as well as competitor 

of Google Currents is Facebook Workplace. Workplace By Facebook offers all 

the same features that Google Currents brings to the table, but Facebook offers 

some extra features as well. These are Knowledge Library, the integration, cal-

culating your potential ROI, and few other useful tools. It has easy-to-use and 

user-friendly interface while their chat support is quite supportive.

2. Yammer by Microsoft
This alternative is from the Microsoft Company. Even though Yammer has 

distinct features, all of its features are the same as those of other company-based 

networking platforms. But one of the interesting facts about Yammer is that over 

85% of the fortune 500 companies are using Yammer for their Campany-based 

communication. Just like Google Currents is available in the Google Workspace, 

Yammer is available in Microsoft 360.

3. eXo Platform
They have been providing company-based networking solutions since 2003.
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They have the anti-fraud system, personalized interface solution, security solu-

tion, and even an option to add domain or connect your company directly on their 

platform. This platform ensures that your desired level of security at all levels 

stays stagnant- application, infrastructure, software development and systems.

Features offered include enterprise collaborative spaces, social networking, 

calendars, task management, document management, video conferencing, 

content publishing, private or team chat, and a unified search function which 

makes data from different sources easily accessible.

4. Salesforce Chatter
Chatter is a Salesforce real-time collaboration application that lets your users 

work together, talk to each other, and share information. Chatter connects, 

engages, and motivates users to work effectively across the organization, irrespec-

tive of their role or location. The embedded apps and custom actions allow users 

to collaborate on sales opportunities, service cases, campaigns, and projects.

If you already use the Salesforce platform, Salesforce Chatter is provides a 

lot extra. Using it, your users can collaborate securely and share status updates 

with each other. Building networks, following people, and sharing information 

are some of the features you can use. You can set up groups and decide who gets 

access to different files.

5. Igloo Software
Igloo Software has helped organizations collaborate, communicate, and engage 

employees by providing exhaustive and robust digital experiences. Igloo is more 
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about the partnership than tech. You can take full advantage of the benefits that 

Office 365 offers - and the investment made by your organization - right out 

of the box with Igloo’s integration with Office 365. Also, Igloo is 100% hosted 

on Microsoft Azure hence you can take advantage from robust standards for 

security, privacy, compliance, and performance. Igloo provides pre-built, easy-

to-configure solutions that help you solve your business challenges quickly.

Google Keep
Nearly a decade has passed since Google Keep was launched. Several years ago, 

Google released numerous free apps. This is one of them. It’s a note-taking app 

that helps you stay organized and productive. Also, it is free. This gives it an 

edge over many other note taking apps and software available in the market. 

Google Keep lets you connect and sync your notes to other Google Workspace 

tools such as Google Docs and Google Calendar. You can use Google Keep in any 

web browser, or download the app on your Android or iOS device. Do you need 

to remember to pick up groceries? Your grocery list will automatically be pulled 

up when you arrive at the store based on your location. Do you need to complete 

something? Be sure you never miss a thing by setting up a time-based reminder.

Features of Google Keep
1.   	Syncs with Google Drive: As you create lists and notes inside Keep, the 

app saves them to Drive, thus making sure that you always have a copy 
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somewhere safe. With your notes placed in Google Drive, you can always 

access them whenever you have a device that can be connected to the cloud.

2.	 Collaborate With Others with Your Notes and Lists: Google’s apps are 

centered around allowing you, as the creator of the information, to collaborate 

with anyone you wish to share the information with. This collaboration fea-

ture is also accessible to Google Keep. Click on any note or list that you want 

to share with another person from your collection of items stored in Keep.

3.	 Easy and Fast to Use: For those who simply want a note taking app that 

is easy to use, which enables them to make quick notes and lists without 

involving numerous steps, Google Keep’s extremely basic interface is ideal. 

It is programmed to run fast, even if you’re using older hardware, because it 

has simple interface. Keep is an equally fast performer in the browser version 

and in the mobile app

4.	 Add Voice Notes Quickly: If you prefer to make notes and lists for yourself 

through voice notes, rather than typing on your device, Google Notes makes 

this an easy process. It allows you to make these recordings quickly. How-

ever, this feature is only available in the Google Keep app for mobile devices. 

Additionally, you can attach your voice recording to any new or existing note 

in Keep, allowing you to play it back whenever needed.

5.	 Add Reminders to Your Notes: When you create a note in Keep, you can add 

a reminder notice to it, such as a date and time for a deadline. The reminder 

is then shared with Google Calendar so that you always have the most up-

to-date information about your schedule. You even can have Keep notify you 

about the note or list based on your location. For instance, if you want the 

list to pop- up on the screen when you reach the grocery store, you can use 

the Remind Me feature plus GPS and the grocery list will appear on your 

screen! 

6.	 Color Coded Note Taking: The various colors available for notes in the Google 

Keep app not only look good, but they also serve a good purpose. You can 

use the multiple colors to differentiate between the types of notes and lists 

you’ve created. Seeing the information that you need at a glance would be 

easy. You can use 10 or more colors to sort and segregate the types of notes 

you have created.

Alternatives to Google Keep

1.	 Evernote
Evernote almost works like a paper notebook where you can jot down hand-
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written notes in various different sections of the notebook. You will also need 

to create multiple folders and subfolders in order to properly organize your 

items in this tool.

2.	 Microsoft OneNote
OneNote provides the option of having the software installed on your computer 

so you can use it without an Internet connection, as well as the option of run-

ning it on your mobile device or from the cloud. OneNote gives you the ability 

to attach files to your notes and lists, such as files from the Microsoft 365 apps 

and PDF files. This essentially means OneNote may work better for a business 

user who needs more extensive collaboration and project planning features 

than what Google Keep is able to deliver.

Druva InSync
Druva inSync’s collaboration with Google Workspace brings to the organizations 

a single access point with the help of which they can view, monitor and protect 

end-user data. This can be done without manually accessing various different 

data sources through disjointed solutions.

Druva inSync basically is a SaaS platform. It delivers unified data protection, 

management of the data, and also information governance at wide scale across 

endpoints and cloud applications. This is done in a safe, secure and compliant 

manner. Druva inSync can be thought of as a service that simplifies the process 

of backup, compliance, archival, and device management with the aim to reduce 

the cost and complexity of supporting regulatory compliance, protecting end-

user data, and also improving data visibility.
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Druva inSync is a performant and versatile service which is developed to 

facilitate backup and recovery of data located on end-user devices. It also aids 

in mitigating data loss and intellectual property theft. Here, backups can be run 

in the background without having any kind of end-user disruption.

Features of Druva InSync:
1. Monitoring of Data compliance:

Druva inSync is one of its kind integrated solutions which maintains visibility 

to end-user data while also providing an automated system to proactively track, 

monitor, and notify of potential data compliance risks. With the help of process 

that automates identifying files that may contain sensitive information, IT can 

quickly assess and take necessary action for GDPR and HIPAA non-compliance 

of end-user data.

2. Federated search

Druva inSync consolidates end-user data and also provides integrated full-text 

search indexing, extensive auditing, and intuitive data visibility. Through this 

organizations can gain better insight into any kind of potential business data 

risks and can also assess necessary issues.

3. Integration with SIEM and identity management tools

Built-in integration with Splunk for Security Information Event Management 

(SIEM) automates the collection of event data from Druva. It further alerts IT 

teams about essential changes in their data, such as data anomalies, unusual 

data activity, and authentication failures.

4. OS migration and device refresh

With an in-built accessible dashboard, inSync enables IT to take care of the 

entire OS migration process at large scale, if needed, through a single interface. 

It provides automated backups of both data and system settings. It, further, 

protects against data loss and integrates mass deployment tools.

Alternatives to Druva InSync
•	 Dell EMC Data Protection Suite:

Data Protection Suite makes use of technologies varying from replication to 

snapshot, backup and disaster recovery, and it delivers protection. This is essen-

tially based on the value of the data and service levels which perfectly aligns to 

business objectives. Dell EMC data protection software is a next-generation data 

management and comprehensive data backup capability. It is such built that it 
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easily meets the needs of organizations of all sizes residing in on-premises or 

multi-cloud environments.

 

•	 Cohesity DataProtect:

Cohesity DataProtect is a superior, software-defined backup and recovery 

solution intended for the cloud era. Created for hyperscale, it presents the all-

inclusive policy-based security for both traditional and modern data sources. 

The software can consolidate backup point products with a single assembled 

platform. It can also eliminate on-prem hardware altogether with SaaS. It offers 

govern UI to handle and also provision for all your backup and recovery services, 

embracing from the core, to edge, and public cloud. 

•	 Rubrik Cloud Data Management:

With the aid of Rubrik Security Cloud, you can maintain data resilient against 

cyber threats, vigorously monitor risks to your data, and effortlessly recover 

your applications. Organizations can run Rubrik anywhere they like through 

plug-and-play appliances on-premises, as software on qualified hardware, or 

even as software in the cloud. You can also archive your data to your public cloud 

provider’s blob storage service. One has to assure minute accessibility of archived 

data with real-time predictive search of cloud storage. You can also extend data 

management to virtualized and physical remote and branch offices. You can 

deploy on qualified industry-leading hardware platforms and cloud providers. 

•	 Commvault Backup & Recovery:

Commvault Complete Backup and Recovery is an integrated platform for data 

protection and management of both on-premises and cloud workloads. The 

key capabilities include snapshots, archive, disaster recovery, data backup, 

granular recovery, replication, cloud migration and protection, content index 

and search, and reporting. You can receive automated backup failure, storage 

usage alerts and also proactively isolate unprotected resources. Other features 

are automation of ticket creation and monitoring, streamlining of operations 

and decreasing failure resolution cycle times. Commvault Backup & Recovery 

can remove the need for last-minute scrambles. 
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